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Introduction 

Letter from the President 
 

Dear Valued Customer, 

During the past several years, we have experienced extraordinary growth and change at ATOM 

Instrument, due to our continued commitment to teamwork, technology-focused product strategies and 

to our policy of placing the trust of our customers above all else. We have successfully reached key 

milestones, expanded research and development initiatives, achieved significant technological 

advancements and initiated our position as a premier manufacturer and developer of analytical 

instrumentation. In the face of challenging economic conditions, we are finding new ways to provide 

solutions to an evolving industry landscape to ensure ATOM remains the brightest light on the 

marketplace. 

The upcoming years will be exciting as we continue to broaden our business efforts and move from 

promise to product. We have set increasingly ambitious goals, but possess the passionate vision and 

resources to achieve them. We have the knowledge, experience and expertise to bring specialty products 

to this niche market, and we know the steps we need to take are simply an extension of what we have 

been doing successfully since our inception. Simultaneously, we plan to continue responding to market 

challenges and expand our line of analyzers with products incorporating enhanced features in order to 

engage a wider customer base. Consequently, we have set an aggressive timeline for the development of 

new products to fulfill our commitment to a "total sulfur and nitrogen analysis solution." 

One of our customers has described our success story as "more a marathon than a sprint." We take pride 

in this characterization and embrace it as the philosophy for our operations as a successful business is 

built on sustainable and reliable growth. In recent years, we’ve grown our business substantially, yet 

managed to never waver from our promise to deliver the very best products and service to our valued 

customers. ATOM is building the analyzer tools of tomorrow, hearing the markets’ demands and we are 

ready to meet the challenges. Watch us closely; the next five years will be a defining notch in ATOM’s 

timeline. 

I credit each of our devoted employees for making these past years such a success in turbulent times. I 

would also like to extend my thanks to our customers and our suppliers for their unfailing sense of 

devotion, responsibility, guidance and support, without which our Excimer light would have surely 

extinguished long ago. 

Thank you for the purchase of this ATOM Instrument product and please trust in our commitment to your 

complete satisfaction. Should you have any concerns, please do not hesitate contacting us for support. 

Sincerely, 

Franek Olstowski, President/Founder 
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Mission Statement 
 

ATOM Instrument is founded on fundamental principles and timeless values that perpetually lie 

at the heart of our business and represent the structural foundation on which it is built. 

These principles have helped ATOM Instrument set a higher standard for its products and 

services, making it a recognized leader for innovative solutions. Our mission is to become a 

market leader in the development and manufacturing of analytical instrumentation with 

unsurpassed performance that will fulfill a strategic role in industry to control processes, verify 

product conformance and help solve a variety of problems for the benefit of society. 

 

Creativity 

– To establish and maintain an environment that encourages creativity and promotes innovation 

in order to capitalize on collective talents and intellectual resources, to maintain a technologically 

advanced position and competitive edge within the market. 

 

Quality 

– To provide superior quality products in both form and function while continually striving to 

improve what may already be the best in its class. 

 

Integrity 

– Above all, to conduct all aspects of business operations while adhering to the highest level of 

business ethics and standards. 

 

Dependability 

– To proactively address and reliably respond to our customer’s needs in a timely fashion. 

  

http://atominstrument.com/tech-overview/
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About This Manual 
 
 This manual is a multipart user’s manual that provides information regarding the proper 
installation, operation and service of ATOM Instrument’s SLA-1000 Sulfur Process Analyzer. The manual 
is divided into the following six sections. 
 

 Section 1  Principle of Operation, Specifications, and Drawings  
 

 Section 2  Software Operation  
 

 Section 3  Basic Maintenance Guide 
 

 Section 4  SLA-1000 MODBUS Digital Communications 
 

 Section 5  ATOM2 Scanner Operation and features 
 

 Section 6  Postscript  
 

 

Warranty, compliance, and safety information concerning the SLA-1000 Sulfur Process Analyzer is 
provided immediately following this page. 
 
The benefits, features and configurations of the SLA-1000 are described in Section 1 along with basic 
theory and operations. 
 
Installation and operation of the SLA-1000 and most optional equipment are illustrated in Sections 2 and 
3 of this manual. Future Information may be supplied in other manuals (i.e., options manuals) or addenda 
to this manual. 
 
Maintenance information includes step-by-step procedures along with a complete set of drawings and 
schematics. 
 
The information contained herein is furnished without warranty of any kind. Users should consider the 
data in this manual only as a supplement to other information gathered by them and must make 
independent determinations of the suitability and completeness of the information. 
 
Some of the terms and labels used in the manual are abbreviated intuitively due to space constraints in 
tables, photos and illustrations. For further explanation, contact ATOM Instrument service.  
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Conditions for Proper Use 

The SLA-1000 analyzer is designed to be installed, operated and maintained as specified in this 

manual. Failure to operate the analyzer as specified may produce erroneous data and possible 

equipment failure which may void the warranty. Some of the conditions for proper and improper 

use of the SLA-1000 analyzer are provided as follows: 

 The SLA-1000 analyzer is designed to continuously analyze liquid samples from a sample 

handling system and display the amount of sulfur contained in the sample. Operation for 

any use other than specified may damage the analyzer and/or cause personal injury to 

the operator. The results obtained from any other use cannot be guaranteed. 

 The standard configuration of the SLA-1000 analyzer is not intended for extended use in 

corrosive environments. 

 The SLA-1000 analyzer can be operated in open, outdoor environments but should not be 

exposed to direct sunlight or precipitation. 

 The best accuracy and precision is obtained when the analyzer is located in a temperature 

controlled environment.  

 To ensure safe operation, the purge system should always be engaged during operation 

of the analyzer except after the area has been determined to be non-hazardous and 

repairs or tests must be performed that require the purge system to be bypassed. Refer 

to the manufacturer documentation included in the appendix sections of this manual 

regarding the purge system operation. 

 The electrical power source for the analyzer must be capable of delivering 2400 Watts of 

power. Note that if the sample heat tracing is powered by the analyzer, up to an additional 

600 Watts may be required 

 The sample to the analyzer must be filtered through a 2-micron (min) filter and delivered 

to the analyzer by an approved, leak-free sample handling system to ensure the sample 

being analyzed is representative of the current process status.  

 The sample handling system should eliminate or minimize “dead volumes” and areas in 

the flow path where new sample can be mixed with old sample.  

 Air and other gas supplied to the analyzer must be filtered and meet specified 

requirements. 

 All cautions and warnings in this manual, on tags and in other publications pertaining 

to the installation, operation and maintenance of the analyzer must be read and 

observed. Failure to consider the warning and caution messages can lead to severe 

personal injury, equipment damage and/or void of the warranty. 

 Instrument should be sheltered from direct sun or rain. If the instrument is to be used for 
very low ppm concentrations, it should be located in a climate controlled area. Ambient 
temperature should be between -20°C to +40°C (-4°F to +104°F). 

  



190514 ATOM SLA Manual Rev A  SLA-1000 User’s Manual 
 

SLA-1000 User’s Manual   Page | 10 

Warnings and Cautions  

 
This manual provides caution and warning messages as listed below. Failure to consider these messages 
can lead to severe personal injury, instrument damage and/or void of warranty. 
 
  

WARNING: POWER MUST NOT BE RESTORED UNTIL ENCLOSURE HAS BEEN PURGED 
FOR 10 MINUTES WITH AN INPUT PRESSURE OF 30 PSIG. 

 

WARNING: A SEVERE ELECTRIC SHOCK HAZARD MAY EXIST WHEN POWER IS 
APPLIED WHILE SERVICING INTERNAL COMPONENTS. Ensure that power 
lines are removed from the power source before continuing.  

 

WARNING: A POTENTIONALLY LETHAL ELECTRICAL SHOCK HAZARD EXISTS WHEN 
CONTACT IS MADE WITH THE 120VAC LINE COMPONENTS. Do not 
attempt to repair or test the 120VAC section without using the 
appropriate test meter with insulated probes.  

 

WARNING: AN EXPLOSION DANGER EXISTS WHEN THE DOOR TO A POWERED 
ENCLOSURE IS OPENED WITHOUT FIRST DETERMINING THE SAFETY 
CLASSIFICATION OF THE OVEN AND THE TYPE OF GASES IN THE AREA. 
The area must be known to be non-hazardous before a powered 
enclosure is opened. Follow the procedures for opening and closing a 
powered enclosure.  

 

WARNING: A POOR GROUND CONNECTION MAY PRESENT A SEVERE SHOCK 
HAZARD. 

 

WARNING: HIGH-PRESSURE GASES SHOULD BE HANDLED WITH EXTREME CARE. 
Ensure that all relevant safety precautions are carefully followed and all 
gas lines, regulators, gas purifiers, etc. are specified for the intended use.  

 

WARNING: A PUNCTURE INJURY MAY RESULT IF THE WAGO CONNECTOR 
INSERTION TOOL IS ALLOWED TO SLIP DURING THE INSERTION 
PROCESS. Some force is required to insert the WAGO tool completely into 
the connector. When possible, use a vice to hold the connector during 
insertion.  
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WARNING: IF THE SPECIFIED OPERATING PRESSURE CANNOT BE MAINTAINED, THE 
SOURCE OF THE LEAK MUST BE CORRECTED BEFORE CONTINUING WITH 
INSTALLATION AND OPERATION. Ensure the sample and main gas flow 
is leak free by performing a leak test. 

 

WARNING: EYE INJURY CAN RESULT WHEN HANDLING THE GLASS COMBUSTION 
TUBE. Wear appropriate eye protection during service, removal and 
replacement of the combustion tube.  

 

WARNING: PERMANENT EYE DAMAGE CAN OCCUR DUE TO LOOKING DIRECTLY 
INTO AN ILLUMINATED UV LIGHT SOURCE. Wear appropriate eye 
protection when looking directly into a UV light source.  

 

WARNING: SEVERE BURNS CAN RESULT WHEN WORKING AROUND A HOT 
COMBUSTION TUBE. Allow the combustion tube to cool before 
performing maintenance.   

 

WARNING: SEVERE BURNS CAN RESULT WHEN WORKING AROUND A HOT 
FURNACE. Allow the furnace to cool before performing maintenance.   

 
 

WARNING: AN ELECTRICAL SHOCK HAZARD MAY EXIST AND SEVERE COMPONENT 
DAMAGE MAY OCCUR WHEN USING A LIQUID LEAK DETECTOR. Even 
though the solution in an approved liquid leak detector “Snoop” solution 
is non-conductive, care should be taken not to wet any electrical or 
electronic components.  

 

CAUTION: Most liquid leak detectors contain sulfur compounds that can 
contaminate the gas supply line and instrument flow path components. 
Care should be taken not to wet or contaminate the analytical flow 
system when using a liquid leak detector. 

 

CAUTION: Become familiar with the location and use of all controls, indicators, 
connections and accessories and carefully read all instructions and 
warning labels prior to operating any portion of the system.  

 

CAUTION: The SLA-1000 should be sheltered from direct sunlight and precipitation 
exposure. 

 

CAUTION: Carefully ensure the system is leak free. Failure to do so may cause 
severe system component damage.  

 

CAUTION: Instrument Air for the sample injection must be set to a pressure of 70 
psi. Lower activating pressure may result in improper actuation while 
higher pressure may cause damage to these valves.  
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CAUTION: Line Voltage to analyzer must be supplied from an External Power 
Breaker with the specified current and voltage properties. 

 

CAUTION: All seals MUST be poured before energizing the unit. 
 

CAUTION: Follow Installation Drawings and Schematics in this manual to bring the 
unit on line. 

 

CAUTION: Do not attempt to operate the SLA-1000 until all installation and setup 
procedures outlined in the previous listed sections of this manual have 
been successfully completed. 

 

CAUTION: Serious instrument damage can result if the SLA-1000 is not fully 
functional and/or if the operator is inexperienced with the computer 
control. 

 

CAUTION: The glass combustion tube is easily broken during removal of the 
transfer tube fittings. Care must be taken not to apply pressure to the 
glass tube when removing the transfer line.  

 

CAUTION: The glass combustion tube inlet and outlet connection points are easily 
broken during removal. Care must be taken not to allow force to be 
applied to the tube when removing these connections from the glass 
combustion tube.  

 

CAUTION: Do not over tighten fittings. Over-tightening can cause restrictions, 
which will affect instrument performance. If ferrules need replacement, 
the fittings should be tightened according to the standard industry 
practice. 

 

CAUTION: The Excimer UV lamp is extremely fragile. Extreme care should be taken 
with these lamps to avoid breakage.  

 

CAUTION: Ensure that all interconnections are properly installed. Improper 
connections may cause damage to system components when power is 
applied.  

 

CAUTION: The Photo Multiplier Tube (PMT) is extremely light sensitive. Any 
exposure to ambient light with PMT power applied will result in 
extreme damage to the PMT. As a result, power to the PMT should 
always be turned off before exposing the PMT window to any ambient 
light. 

 

CAUTION: Ensure all inlet and outlet openings are kept clean and free from 
contaminants. It is recommended that the inlet and outlet openings be 
covered with tape when not connected to lines.  
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CAUTION: Do not exceed recommended pressures. If higher pressures are used, 
severe and irreparable damage may be done to fragile system 
components.  
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Warranty 
 

 
ATOM Instrument SLA-1000 Standard Warranty 

Atom Instrument warrants that all products supplied will be of merchantable quality and will comply with 
the specification agreed for them. 
 

Atom Instrument guarantees for a period of twelve months from installation of the product or fifteen 
months from delivery to the customer, whichever is the shorter, all Products and spare parts sold 
hereunder. 
 
ATOM Instrument will repair or replace defective and/or nonconforming parts without charge for material 
or labor service during the warranty period. 
 

Products that have been repaired or replaced during the warranty period are themselves warranted only 
for the remaining portion of the original one (1) year. 
 

Repairs, adjustments and service performed after the expiration of the one (1) year warranty period shall 
be charged to the owner/purchaser at the then current prices for parts, labor, and travel related expenses. 
 

Exceptions to this warranty are: 
 

- Defects, damage, or nonconformity resulting from abuse, misuse, neglect, lack of reasonable care, 
unauthorized modification, or the attachment of improper devices to the products. 

- Installation, operation and maintenance of the products in a manner that does not meet ATOM 
Instrument specifications will void this warranty. 

- All requests for service or repair under this warranty must be received within the warranty period 
by ATOM Instrument or its authorized representative. 

 

The warranties contained in this agreement are in lieu of all other warranties, expressed or implied, 
including the warranties of merchantability and fitness for a particular purpose. 
 

Statements made by any persons, including representatives of ATOM Instrument, which are inconsistent 
or in conflict with the terms of this warranty shall not be binding upon ATOM Instrument unless reduced 
to writing and approved by an officer of the company. 
 

Liability covered under this warranty is limited to the original cost of the ATOM Instrument supplied 
equipment. ATOM Instrument will not be liable for consequential damages including but not limited to 
loss of production, throughput or off specification product due to user or equipment error.  
 

This warranty shall be governed by and construed in accordance with the laws of the State of Texas. 
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Service  
Service Contact Information 
 
Address:         Phone Number: 
1656 Townhurst Dr, Suite B  713-461-0034 

Houston, TX 77043 

 

Service Rate Information 
Effective: January 1, 2019 

 
ATOM Instrument offers quality service and preventative maintenance work at reasonable rates.  
Our goal is to provide consistent and reliable service with an emphasis on customer satisfaction.  
 
Hourly Field Service Rate:  
Standard Rate (Regular Business Hours 8am-6pm)      $ 237.50 / Hour  
Premium Rate (Outside of Regular Business Hours)      $ 300.00 / Hour  
 
Field Acceptance Test (FAT):  
At ATOM Instrument Locations (1st Analyzer)       $2,400 / Unit 
At ATOM Instrument Locations (From 2nd Analyzer)      $1,900 / Unit  
At Customer Site          $1,900 / Day  
Additional Day at Customer Site        $1,900 / Day  
 
Minimum Charge:  
2-Hour (Customer Location less than 100 mi. from Houston)     $ 475.00  
4-Hour (Customer Location greater than 100 mi. from Houston)     $ 950.00  
 
Travel Rate:  
Travel Time           $ 125.00 / Hour  
Travel Day (8 Hour/ day maximum)        $ 1000.00 / Day  
Foreign Countries (Flights Longer than 6 hours from Houston)     $ 2000.00 / Day  
Personal Auto Mileage (Rounded IRS Mileage Rate for 2019)  
 
Reasonable Travel Expenses:           
(Airfare, lodging, surface transportation, meals, etc.)     Actual Cost  
 
Misc. Charges:             
(Includes license fees, customs fees, excess baggage fees, training fees, etc.)  Actual Cost 
 
Cancellation Charges:  
Prior to departure for travel expenses incurred       Actual cost  
(i.e. fees for cancellation of airline, hotel, or rental car reservations, plus time spent)  
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In-house repair:  
Includes repairs done at ATOM and parts or assembly preparation time for   $150.00/Hour 
service visit.   
 
Annual Preventive Maintenance Plan:  
1 day field service work to perform PM (must be scheduled within valid plan year  Based on  
on mutually agreed upon date)        Analyzer and 
Parts replaced during PM- sample valve, combustion tube, transfer tube with  site location  
ferrule (for SLA only), thermocouple (any additional parts required to be invoiced  
separately) 
Software updates 
Year around phone support (provides for return call within 4-6 hrs. anytime during  
valid plan year) 48 hrs. onsite response time for service calls (within valid plan year  
only; time and expenses invoiced additionally to plan price).   
 
Payment Methods:  

 Purchase Orders from customers with approved credit, Net 30 days.  

 Credit Cards Accepted (MasterCard, VISA, American Express and Discover)  
 
Limited Warranty  
Any replaced parts and service labor performed in replacing associated parts is warranted for a period of 
90 days from the date of service. This warranty excludes travel time and expenses if returning to 
customer site to make repairs is requested. ATOM attempts to maintain stock of essential parts that 
may be necessary for general repairs and preventative maintenance. 
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Recommended Consumable Spare Parts List 
 

Part Number Description Quantity 
60064-00001 SLA Online Combustion Tube, 10.75 L 1 
60038-00001 Combustion Furnace 1 
60097-10005 Assy, Thermocouple, Single S Type 1 
23058-00002 Valve, 4-Port Internal Sample Injector, Valcon E, 2µl, High-Temp 

Air Actuator 
1 

23300-00250 Transfer Tube .010" ID x 9" Long 1 
10676-00001 Ferrule, External Reducing, 1/16" to 1/32", Polyamide, Valcon 1 
11228-00001 Dryer,  .110" ID, 72" L, Fluorocarbon Fittings 1 
60008-10001 Excimer Lamp Envelope 1 
10027-00001 Ferrule, Standard 1/4", Graphite, (2/Pk) 6 

 
 

Recommended Replacement Spare Parts List 
 
  

 SAMPLE ENCLOSURE SECTION 
23058-00002 1 VALVE, 4-PORT INTERNAL SAMPLE INJECTOR, VALCONE, 1µL, HIGH-

TEMP AIR ACTUATOR 
11258-00001 1 THERMOCOUPLE, TYPE K, 6" LONG  

10027-00002 1 FERRULE, STANDARD 1/8", VESPEL 

23300-00250 1 TRANSFER TUBE .010" ID X 9" LONG 

10676-00001 1 FERRULE, EXTERNAL REDUCING, 1/16" TO 1/32", POLYAMIDE, VALCON  

60037-10001 1 ASSY, HEATER, SAMPLE ENCL 
 

   
 

 COMBUSTION FURNACE SECTION 
60038-00001 1 COMBUSTION FURNACE 

60097-10005 1 ASSY, THERMOCOUPLE, SINGLE S 
 

 
 

 
 COMBUSTION KIT - INCLUDES: 

60064-00001 1 COMBUSTION TUBE  

10027-00001 1 FERRULE, 1/4", GRAPHITE (2/PK) 

23251-00001 1 TUBING, PTFE TEFLON. 1/8" O.D .X 1/16" I.D. (10FT./PK) 

23252-00001 1 FERRULE, SET, 1/8” (10/PK) 
 

   
 

 MAIN ENCLOSURE SECTION 
23248-00001 1 COMPUTER, TOUCH SCREEN, 12IN 

60203-10001 1 ASSY, COMPUTER SCREEN PROTECTOR 

23135-00001 1 Z-PURGE  

60037-00002 1 ASSY, HEATER, ELECTRONICS ENCL 

11572-00001 1 VALVE, SOLENOID, 3-WAY 
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11572-00002 1 VALVE, SOLENOID, 4-WAY 

11478-00001 1 CONNECTOR, DIN, MANIFOLD, 24VDC 

23242-00001 1 PRESSURE SWITCH ASSY, ADJUSTABLE, 4-125 PSI, 7A, 250V 

23245-00001 1 MASS FLOW CONTROLLER, AIR 500 SCCM 

11506-00001 1 TEMPERATURE CONTROLLER, SSR OUT, 24V 

11280-00001 1 SOLID-STATE RELAY (SSR), 25A, 240 VAC 

11233-00001 1 UNIVERSAL SIGNAL CONDITIONER, 24V, 4-20 MA OUT 

11224-00001 1 THERMOCOUPLE, 30 AWG TYPE K, PFA 

11262-00001 1 THERMOSTAT, 1/2" DIS, AUTO RESET, 15A OPEN@  48.9C, CLOSE@ 
32.2C 

11525-00001 1 SOLID-STATE RELAY (SSR), 5VDC, DIN MOUNT  

11526-00001 1 RELAY, 24V, DIN MOUNT 

23123-00001 1 POWER SUPPLY, 24V, 4.2A, 100W, DIN RAIL 

60078-10001 1 SP-2000 SIGNAL PROCESSOR BOARD PCA 

60059-10001 1 EXTERNAL INTERFACE BOARD PCA 

60079-00004 1 DC/DC CONVERTER, QUAD 24/5V,+15V,-15V,12V 

60003-10001 1 DETECTOR WITH PMT 

60008-10001 1 EXCIMER LAMP ENVELOPE 

60001-10001 1 EXCIMER LAMP ASSY 

11228-00001 1 DRYER,  .110" ID, 72" L, FLUOROCARBON FITTINGS 

23109-00001 1 REGULATOR, AIR, 0-60 PSIG 
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SLA-1000 Preventive Maintenance Schedule 
 
 

Recommended schedule for parts replacement * 
 
 

 2 years ** 
 

PART NUMBER DESCRIPTION  

60097-10005 ASSY, THERMOCOUPLE, SINGLE TYPE S  

60064-00001 COMBUSTION TUBE  

10027-00001 FERRULE, 1/4", GRAPHITE (2/PK)  

23058-00002  SAMPLE VALVE, 4-PORT, 1μl  

 
 
 4 years ** 

 

PART NUMBER DESCRIPTION  

60038-00001 FURNACE, ON-LINE ANALYZER  

60097-10005 ASSY, THERMOCOUPLE, SINGLE TYPE S  

60064-00001 COMBUSTION TUBE  

10027-00001 FERRULE, 1/4", GRAPHITE (2/PK)  

23058-00002  SAMPLE VALVE, 4-PORT, 1μl  

 
 
 6 years ** 

 

PART NUMBER DESCRIPTION  

60008-10001 ENVELOPE, EXCIMER, UV LAMP  

60097-10005 ASSY, THERMOCOUPLE, SINGLE TYPE S  

60064-00001 COMBUSTION TUBE  

10027-00001 FERRULE, 1/4", GRAPHITE (2/PK)  

23058-00002  SAMPLE VALVE, 4-PORT, 1μl  

 
 
* these are the minimum recommended replacement intervals and are based on 
   customer provided data; customers are urged to use their discretion to choose schedule for 

        parts replacement  
 

** this only lists typical recommended parts, any other parts if needed, will be additional- 
     please take this into account when planning for budgetary purposes 
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Section 1 – Principle of Operation, Specifications, and 

Drawings 
 

Section 1.1 Principle of Operation 
 

The ATOM SLA-1000 is an online process analyzer utilizing patented Excimer UV Fluorescence 
(EUVF) technology to measure Total Sulfur in a variety of applications such as monitoring of total 
sulfur in liquid process streams. 
 
The UV Fluorescence method (UVF) is one of the most simple and practical low-level sulfur 
analytical techniques that has been widely used and proven over many years of industrial 
utilization. The UV Fluorescence method involves injection of a sample into a high-temperature 
oxidation or combustion furnace, which converts all hydrocarbons into water (H2O) and carbon 
dioxide (CO2) byproducts. Total Sulfur content contained in any molecular-bound hydrocarbon 
species is similarly oxidized at temperatures in excess of 1000°C into sulfur dioxide (SO2) by the 
reaction: 
 

R-SH + O2 → SO2 + CO2 + H2O 
 
The furnace effluent containing these combustion byproducts is directed into a detection 
chamber where it is excited by high-energy, short-wavelength emission from a UV excitation 
source. The UV photons from the excitation source or lamp, transfers energy into the SO2 
molecule and raises its energy level to create an excited singlet state. These excited molecules 
rapidly decay back to their lower energy ground state releasing the absorbed energy as a 
secondary emission known as fluorescence. 
 

SO2 + hυ → SO2* → SO2 + hυ’ 
 
This low-level fluorescence emission is optically filtered to remove undesired wavelengths of the 
UV source and background scatter within the detector chamber. Detection of the filtered 
fluorescence emission is usually accomplished with a Photomultiplier Tube (PMT), Channel-Plate 
Multiplier (CPM) or other high gain, light-sensitive detector.  
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Section 1.2 Specifications 
Analytical Performance       

Measurement Method   Total Sulfur by Excimer UV Fluorescence (EUVF) 

Measurement Range   0.5 ppm – 10,000 ppm (Application dependent) 

Repeatability   200 ppb SD or ±2% of measured value, whichever is greater  

    

100 ppb SD with 5-min. averaging or ±2% of 
measured value, whichever is greater  

Linearity     ±2% of full scale 

Response Time    99% in one cycle (60-100 s typical)   

Calibration   Automatic or manual   

         
Analog/Discrete Data 
Communications      

Analog Outputs   Two 4-20 mA DC (optional)   

Alarm Outputs    

 
One global dry contact triggered by one or more of the 
following: 

    

Power Failure, Loss of Purge, Low Oxidizer Pressure, User-
configured Digital Inputs (DI4 – DI7) 

     
Digital Data 
Communications  RS-232, RS-485/422 MODBUS  (TCP/IP optional) 

        
 
Local MMI    12" Touchscreen Computer with Embedded Windows 7  

    

allows complete operation and control of all analyzer 
functions 

 
Remote Interface   Complete control of ATOM SLA, including monitoring of  

    analysis parameters and digital data values 

         

Utility Requirements       

Ambient Temperature   -20°C to +40°C (-4°F to +104°F)  
Power     120 VAC, 25 A, 50/60 Hz at 3000 watts  
Instrument Air    70 psig (4.8 bar), 7 SCFM, Oil Free, -40°C (-40°F) dew point 

Zero Grade Air     40 psig (4.8 bar), 200 SCCM   

         

Physical Parameters       

Dimensions   

965.2 mm (38.0 in) high x 660.4mm (26.0 in) wide x 304.8 mm 
(12.0 in) deep 

        

Mounting   Wall or Unistrut Stand   
 
©2016 ATOM Instrument, LLC. All rights reserved. Specifications, terms and pricing are subject to 
change. 
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Section 1.3 SLA-1000 Drawings 
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Section 1.3.1 Installation Drawings 
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Section 1.3.2 Process Flow 

Diagram 
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Section 1.3.3 Total System Wiring 
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Section 1.3.4 Main 

Enclosure 
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Section 1.3.5 Furnace Enclosure 
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Section 1.3.6 Sample Enclosure 
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Section 2 – Software Operation 
 
This section of the manual is intended to provide a complete overview of the SLA-1000 software 
providing the user a fundamental understanding of analyzer operation.  
 
There are 3 programs incorporated into SLA-1000 software that have distinct functions, but work 
together to provide complete control and user interface of the SLA-1000 instrument. The main 
SLA-1000 software program operates in the background and controls all aspects of analyzer 
operation, which includes protocols for communicating with the detector module. The detector 
module firmware is a distinctly separate, machine-language program embedded in the onboard 
microprocessor. The third program is a colorful, high-contrast Graphical User interface or GUI 
that provides a user-friendly interface comprised of an organized set of intuitive menu screens 
that are configured for ease of use. 
 
 

Start Up  
 
Upon powering up the SLA-1000, the touchscreen will begin to turn on and Windows 7 will boot. 
If an administrator password has been set up for Windows 7, the password can be entered using 
an external keyboard plugged into a USB port to access the software. If no keyboard is connected, 
the touchscreen keyboard can be displayed by pressing the “Ease of access center” button at the 
bottom left of the screen and then selecting the “Type without the keyboard (On-Screen 
Keyboard)” option. 
 
If no Windows administrator password has been implemented, the main GUI menu (Figure 2.1) 
will open automatically after the SLA-1000 and touchscreen computer are powered on. All sub-
menus may then be accessed from this bar found at the top of the desktop screen.  
 

 
Figure 2.1 – Main Menu 

 
In order to access any of the sub-menus of the GUI, the user must first log into the system. Refer 
to section 2.1.1 for Login information  
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Section 2.1 File Menu 
 

 
Figure 2.2 – File Drop down Menu 

 

Section 2.1.1 Login 
 

The Login feature allows users to interface with the software on two separate levels. Users 

without administrative privileges are limited to menu access for viewing purposes only. Those 

users with administrative privileges have complete access to all menu settings, which can be 

modified as necessary for customizing or optimizing instrument operation (selectable in User 

Setup, Figure 2.6). The Login feature is intended to prevent unauthorized changes to instrument 

operation, allowing it to retain current settings unless an authorized user logs in with valid 

credentials (Figure 2.3).  

 

To log in to the analyzer, click File > Login. Select the ID line. 

  

 
Figure 2.3 – Login Screen 

 

A touchscreen keyboard should automatically pop-up on the screen (Figure 2.4).  

 

 
Figure 2.4 – Touchscreen Keyboard 
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Using the touchscreen keyboard, enter the username ID. Then Select the Password line and enter 

the user assigned password. After proper user credentials have been entered, press the OK 

button to complete the Login process.  

 

NOTE: At any attempt to access a screen that requires administrative privileges, the Login 

screen will automatically pop-up and prompt the user for the required credentials.   

 

NOTE: The dropdown menu will read Logout if a valid login has already been entered 

(Figure 2.5). 

 

 
Figure 2.5 – User Already Logged In 

 

There is an auto-logoff feature in place to automatically logout any user after 15 minutes of 

inactivity. After this time, any screen that requires administrative privileges to change or modify 

settings will automatically cause the Login Screen to reappear and prompt the user to re-enter 

the required credentials. 

 

 

Section 2.1.2 User Setup 
 

The User Setup screen is accessed from File > User Setup. Three levels of user privileges are 

assigned and defined as Admin, Tech and View (Figure 2.6). 
 

 
Figure 2.6 – User Settings Screen 
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Below is a description of each user’s privilege: 
 

 Admin Tech View 

View any GUI screen X X X 

Modify analyzer parameters X X  

Modify user privileges X   
 

When logged in as a system administrator, pressing the  will delete the corresponding user 
profile. The factory “admin” cannot be deleted nor can the name be modified. However, 
subsequent users with “Admin” privileges can be created or deleted.  The administrator can add 
users and assign/change a user’s privileges.  To add a user, click on the last empty ID field and 
enter the user name, a password and then select user level (Admin/Tech/View) to finish user 
registration. 
 

Section 2.1.3 Exit  
 

By clicking File > Exit, the GUI program will close; however the SLA-1000 main program will 

continue to run if there are no operational restrictions, such as loss of purge or other system 

critical alarm function.  

 

 

Section 2.2 Settings  
 

 
Figure 2.7 – Settings Dropdown Menu 
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Section 2.2.1 Home 

 

The Home Screen is the top screen in the Settings menu and is considered to be the primary user 

interface for an overview of routine analyzer operation. (Figure 2.8). The Home menu functions 

are arranged in groups and are discussed separately.  

 

 
Figure 2.8 – Home Screen Detailed 

 

Stream Selection and information 

 

Start Stream 

This setting allows user to select the starting order of stream analysis when the Analyzer 

begins analyses, either from a reset, or from a “holding” state. 

 

Stream Select 

In this part of the home screen, the user may select streams to be run by checking the 

box adjacent to the desired stream(s). At least one of the streams check box must be 

selected and number of cycles for selected stream entered must be a value greater than 

zero for analyses to commence. 
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Run 

This indicates which stream is currently being analyzed. 

 

Cycles 

The user can set the number of cycles each stream is sequentially run before switching 

streams by clicking the Cycles button that will open a text box that allows the user to 

select between 1 and 9 cycles per stream (Figure 2.8(a)).  

 

 
Figure 2.8(a) – Enter Value Screen 

 

When a stream being analyzed, a green radio button is activated next to the stream being 

analyzed. The Cycles Run counter indicates analysis progression. When all cycles 

requested by the user are completed, the analyzer switches to the other stream (if both 

streams are checked). 

 

Analyzer “Online” 

 

This button is tied to Modbus Register R00007 to inform the DCS whether or not the 

Analyzer is undergoing maintenance.  The DCS can then ignore probable erroneous data 

while Analyzer is “Offline”. 

 

Density 

 

The stream density value is entered here, which is used for calculating weight-adjusted 

total sulfur concentration. Click on the density value button to open a text box where 

stream density can be manually entered.  The typical range for density is > 0.0 and < 1.0.  

If a value is not entered, or is 0.0, the ATOM considers that the default concentration is 

1.0 and calculates sulfur concentrations accordingly. 

 

Run Cycle Status 

 

The Run Cycle Status section of the Home Screen displays information regarding various 

aspects of the Cycle in process. 
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Start/Stop Button: 

The analyzer software is designed so that the Analysis Cycle runs all the time, and will 

automatically restart upon restoring power after a power shutdown. Exceptions to the 

continuous run feature are: 

 

1. There is an Alarm condition. 

2. The Run Cycle is manually stopped. 

3. The analyzer is Purging due to an Auto Calibration Check, or return to 

Process. 

4. The analyzer is in a “Holding” state as part of the Run Cycle Mode. 

 

When the button is labeled STOP with a green LED, a cycle is either running, or is 

scheduled to run. Pressing this button will cause the cycle to stop after the current cycle 

has completed. When stopped, this button will be labeled START with the LED off. 

Pressing this button again will change the label to STOP and initiate a new cycle run. 

 

Event Indicator 

Beneath the START/STOP button is an indicator that displays various events related to the 

Run cycle. Some of the events the Event Indicator will display are, Not Ready, Holding and 

Purging. Whenever a cycle is currently running, it will display timed events as they occur 

such as Injecting, Baseline Evaluation and Peak Integration periods.  

 

Cycle Time 

The Cycle Time in the Run Cycle Status displays the current cycle time in elapsed seconds. 

A typical cycle time for the ATOM Analyzer is 100 seconds. Once the current cycle is 

completed, it will start a new cycle at time 0. 

 

Cycle Number 

The Cycle Number displays the total number of completed cycles the analyzer has run 

since the analyzer was started. This number will increment until the cycle is stopped and 

will continue to increment once the cycle has restarted. This number will reset whenever 

the Analyzer is stopped. 

 

System Control 

 

The System Control section of the Home Screen shows the status of the PMT and UV Lamp 

voltages, the presence of any Zero baseline offset value, and the Alarm/Warning status 

of the system.  
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PMT HV  

This button controls high voltage to the Photo-Multiplier Tube and indicates whether it is 

ON or OFF. The LED will be GREEN if powered ON and is turned OFF by pressing the button 

to toggle.  

 

UV Lamp 

This button controls power to the Excimer Lamp Module and operates in similar to the 

PMT HV button in its ON/OFF functionality.  

 

Zero BL 

This button allows any baseline level to be zeroed for graphic display purposes, or the 

analyzer analog output when the detector signal is selected. This function must be 

enabled in the Detector Settings Screen which will be discussed later in the Software 

Operation section. Zeroing the baseline level will not affect acquired results or 

calculations of total sulfur composition.  

 

Analyzer Alarm Status 

This line will display Normal with green LED when the analyzer is running properly. This 

line will display Warning with yellow LED indicating a situation that requires user 

intervention but is not critical enough to affect normal analyzer function. Should a system 

critical situation arise, this line will display Alarm with red LED indicating an alarm 

condition exists.  If this occurs, the Analyzer is designed to immediately abort the current 

Run Cycle, shut down power to the combustion furnace, and activate the Global Alarm. 

(Figure 2.9) 

 

  

  

 

 

 

 

                              

 

Figure 2.9 – Normal, Warning, and Alarm Status 

 

NOTE:  The status of this indicator will also be prominently flashed on top of the menu 

bar should the Analyzer go into either WARNING or ALARM mode. 
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Variable Display Section 

 

The Variable Display section allows user to monitor up to three selected variables from a 

view options list.  The associated bar graphs can be appropriately ranged to provide a 

customizable display as per the user preference. Although any combination of variables 

can be chosen, the graphs are set by default to Detector mV, Stream 1 ppm and Stream 2 

ppm. These displays will hold their current value until a new value is calculated, replacing 

the previous reading with the most recent one. Pressing any of the three buttons above 

the graphs will open a list of available display variables, which can be selected by 

highlighting the intended variable and pressing the OK button. (Figure 2.10) 

 

 
Figure 2.10 – Variable Display Selection Menu for View 2 
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Pressing the RANGE button allows the bar graph range to be selected in a likewise fashion. 

The desired range is chosen by selecting the adjacent radio button (Figure 2.11).  

Alternatively, it is possible to choose a user defined range in the bottom last line of the 

table. 

 

 
Figure 2.11 – Variable Range Selection Menu 
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Section 2.2.2 Calibrate Settings 
 

The Calibrate settings screen (Figure 2.12) is where all information regarding instrument 
calibration and associated calibration results are displayed.  
 
To access this screen press Settings > Calibrate Settings 
 

 
Figure 2.12 – Calibrate Settings Screen 

 
Check Cycle Status 
 

The Check Cycle Status allows the user to monitor and review acquired Check Cycle 
results, as well as the progress of the Check Cycles in progress.  
 

  View Results  
Pressing the View Results button opens a separate menu and displays up to ten runs in a 
Cycle Set, allowing them to be viewed as they occur during Manual or Auto Check Runs. 
The results displayed are computed with the Response Factor (RF) currently in use  
(Figure 2.13). 
 
If a calibration check is in progress, results are updated in real-time as they occur. If the 
last calibration check is finished, these results will display all acquired values within the 
last calibration check set. Although “check calibration” results can be viewed at any time, 
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they will be wiped clean and replaced with new data whenever the next Manual or Auto 
Check calibration is performed. Both Zero and Span sections display Area and 
Concentration values associated with the calibration check, as computed with the 
previously accepted Response Factor (RF). 
 

 
Figure 2.13 – Check Calibration Results Screen 

 
  Cycles Run 

The Cycles Run Line indicates the number of completed runs from the number of cycles 
selected for the calibration check set. 

 
Cycle Controls 
 

The Cycle Control section of the menu allows the user to set the number of calibration 
cycles desired for each Check Calibration Set, as well as the amount of purge time 
between cycles.  
 
Cycles/Set  
The Cycles/Set button allows any number of cycles to be selected between 1 and 10 for 
the desired set of runs. This number of cycles will be applied to each Zero, Span or Validate 
samples when selected. By pressing the Cycles/Set button a window will pop-up as well 
as the touchscreen keyboard in order to enter the desired number of cycles to be run. 
Press OK to set this value. (Figure 2.14) 
 

   
  Figure 2.14 – Enter Value Screen  

NOTE: The Enter Value Screen 
will pop-up throughout the 
software when required.  
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  Purge (Sec) 
The Purge (Sec) button allows the user to select the purge time between sets. This is 
intended to allow sample concentrations to reach equilibrium prior to starting a 
calibration check set. The optimal time setting will depend on sample flowrates and dead 
volume between the selection valves and analyzer. 
 
The purge time will be applied during transition times between running process and a 
calibration check sample, between each set of calibration checks, and before returning to 
running the process sample. 
 
If the analyzer is in purge mode, the Home Screen will display Purging on the event line 
and the clock counter will decrement from the chosen setting to “0” seconds.  
 
** Note:  A loss of purge will cause the analyzer to go into “Alarm”, and the 

analysis is stopped immediately.  If this Alarm event occurs right after 
sample injection, then this sample will still be present in the system even 
after the alarm condition clears.  Once the Alarm is cleared, the analyses 
resume after purging for the set duration (Purge (Sec) set as shown 
above under Calibration Settings).   

 
If the purge is set for a shorter duration, it may not be enough to sweep 
the previously injected sample out of the system, before the next sample 
injection.  This increases the probability of system coking.  To avoid this, 
it is recommended that the Purge Time be set to a minimum of 60 
seconds. 

 
Calibrate Values 
 

This section displays all values used or associated with instrument calibration.  
 
Check Zero and Span  
The Check Zero and Check Span buttons display acquired values from the most recent 
calibration check. After the calibration checks are finished average calculated areas of 
Zero and Span will be displayed in these buttons. These values will be used for analyzer 
recalibration if considered acceptable by the user. Calculated values can be overridden 
with any User specified value.  

 
Saved Zero and Span 
Values on these lines display previously accepted areas utilized for calibration purposes.  
 
Zero and Span Concentrations 
The Zero Conc and Span Conc buttons allow the user to enter known concentration of 
samples, generally utilizing the certified values provided by the calibration gas supplier. 
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The Cal Units button allows the user to select the concentration for both values to be 
entered in either percent or PPM. 
 
Cal Density 
The Cal Density button allows the user to enter the density of the Calibration standard. 
After entering the Cal Density, this value does not get updated unless “Calculate RF” and 
then “Save Calibration” buttons are pressed. If the Cal Density is not set, or is 0.0, the 
ATOM uses a default value of 1.0 and calculates sulfur concentration accordingly. 
  
RF=Count/ppm 
The RF=Count/ppm button displays the most current response factor. The response 
factor (RF) is the principal number used to calibrate the instrument representing peak 
area counts/ppm and is a value proportional differential area between span and zero 
divided by the differential in respective concentrations. 
 
If the user wishes to modify the calculated RF, or run the instrument with a specified user-
defined RF value, the user may press the RF=Count/ppm Button and merely enter the 
desired RF.  

 
Manual Check 
 

The Manual Check section allows the user to manually run a ZERO, SPAN, or VALIDATE set 
of run cycles. The ZERO and SPAN functions will use the sample bottles that are connected 
to their respective inputs to calibrate the SLA-1000. The VALIDATE function will run any 
concentration of a known sample to ensure the SLA-1000 accurately measures the 
intended concentration. 
 

Auto Check 
 

The Auto Check section of the Calibration Settings allows the user to set up routine 
calibration checks.  
 
The Enable button enables or disables auto check feature, as indicated by the embedded 
LED. Any or all of the three possible gas standards can be included in the Auto Check run 
by selecting the adjacent box to include a checkmark. The user can also specify the desired 
auto check schedule utilizing the Freq (Days) and Time (24Hr) buttons. The time of day is 
always entered in 24-hour format. 
 

Demo Mode 
 

The Demo Mode button allows the user to utilize previously recorded data in place of 
real-time detector data to gain familiarity with analyzer operation, without having to run 
actual samples. The Demo Mode feature is enabled by pressing the button as indicated 
by the lit LED.  
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If the SLA is analyzing process sample when Demo Mode is enabled, normal detector 
signals will be substituted with pre-recorded data from a 50% concentration sample at 
the end of the current Run Cycle.  
 
If the SLA is analyzing calibration sample, whether in Manual or Automatic mode, the 50% 
concentration sample data will be substituted whenever Span is selected. 
 
If Zero gas is selected, a different set of pre-recorded data representing near-zero sample 
concentration will be utilized. If Validate is selected, pre-recorded data representing 25% 
total sulfur sample concentration will be utilized. 
 
It is important to note that there are a total of 7 continuous runs recorded for each of the 
above pre-recorded concentrations. If more than 7 cycles are selected to run in a cycle 
set, the pre-recorded analysis data will merely repeat every 7 cycles, and include any 
portion thereof necessary to complete the intended set. The detector will return to 
processing normal real-time signals after DEMO mode is turned OFF.  

 

Last Validation 
 

This section of the menu shows the calculated average concentration and the date and 
time of the last calibration validation the SLA-1000 performed. 

 
Calculate RF 
 

 After Manual or Auto Check is complete, the analyzer will display the new data for zero 
and span values in the “Check” section. Pressing the “Calculate RF” will automatically 
calculate the response factor based on the difference between Zero and Span areas from 
the latest Check Calibration run. 

 
Save Calibration 
 

 Whenever any calibration check information has changed, such as completion of a 
calibration set, manual change to calibration check values, or a response factor that has 
either been calculated or manually entered, the Save Calibration LED will indicate new 
calibration values that remain to be entered. All changes will not come into effect until 
the Save Calibration button is pressed. 
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Section 2.2.3 Detector Settings 
 

The Detector Settings screen contains information about the detector and settings that can be 

altered (Figure 2.15).  

 

To access this menu press Settings > Detector Settings 

 

  
Figure 2.15 – Detector Settings Screen 

 

Detector Settings 

 

This part of the menu allows the user to change the PMT HV (Photo-Multiplier Tube High 

Voltage) and change the filtering constant of the data collected. 

 

The PMT HV button lets the user change the high-voltage applied to the PMT to adjust 

detector sensitivity and associated peak height to the desired level. The PMT HV default 

value is 800V, but is typically modified as necessary at the factory. The maximum voltage 

setting is 1099 volts.  

 

The Filter (sec) button controls the detector filtering constant, or a rolling “box-car” 

average of individual 1-sec detector count readings. The optimal setting for the SLA-1000 

is 8 seconds for best results, which is a time constant that allows maximum smoothing of 

detector data without significantly affecting overall peak height.  

 

Baseline Correction 

 

This section allows the detector baseline to be modified as desired for graphing or output 

purposes. 



190514 ATOM SLA Manual Rev A  SLA-1000 User’s Manual 
 

SLA-1000 User’s Manual   Page | 47 

The Zero Enable button allows the baseline to be zeroed either manually, or 

automatically. To turn this function ON press the Zero Enable button and the indicator 

will turn GREEN. To turn it OFF press the button again and the indicator will be BLACK.  

  

Manual zeroing of the baseline is accomplished by pressing the Zero BL button in the 

System Control Section of the Home Screen. Automatic zeroing of the baseline is defined 

in the Timed Events Settings and will occur during the programmed time. Even if the Zero 

Enable button is enabled, a program time of “0” will prevent automatic zeroing of the 

baseline. 

 

Applied μV 

The Applied μV line displays the voltage applied to the normal detector baseline to shift 

it to zero. This value is cumulative each time the baseline is zeroed either manually or 

automatically. When the Zero Enable button is turned off, any cumulative offset value is 

dropped and the baseline will return to its normal state. 

 

Offset μV 

Whether the Zero Enable button is enabled or not, the Offset μV button allows the user 

to readjust the baseline to any desired value. 

 

Run Cycle Settings 

 

The Run Cycle Settings allow the mode of cycle operation to be selected. The three modes 

of operation are Repeat, Hold and Stop. 

 

If the selected mode is Stop, a running cycle will stop at the end of programmed cycle 

time. If the selected mode is Repeat, a new cycle will immediately restart after the current 

cycle ends. If the selected mode is Hold, a new cycle will start after the Hold time has 

elapsed. Whether the analyzer is in Repeat or Hold modes, cycles will run continuously 

until a) the cycle is manually stopped; b) an alarm condition arises; or c) power to the 

analyzer is turned off. 
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Section 2.2.4 Digital I/O Label 
 

The Digital I/O Label screen contains assigned names for all digital inputs and outputs  

(Figure 2.16).  

 

To access this menu press Settings > Digital I/O Labels 

 

 
Figure 2.16 – Digital I/O Labels Screen 

 

The Digital I/O labels above have been assigned as default names by the factory. To change any 

of these, the text is selected by pressing the desired line, which will pull up the touchscreen 

keyboard. The user then enters any alternate name or text desired, and presses the OK button. 
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Section 2.2.5 Digital I/O Status. 
 

The Digital I/O Status screen is consolidated screen to check the status of all the digital inputs 

and outputs (Figure 2.17).  

 

To access this menu press Settings > Digital I/O Status 

 

 
Figure 2.17 – Digital I/O Status Screen 

 

DI (Digital Input) Status  

 

This section displays the digital inputs in their normal operating state. Digital inputs 1-3 

reflect the presence of system critical parameters that are described in the System Setting 

menu. Digital Inputs DI4 – DI7 are user configurable. All Digital Inputs DI1 – DI7 are “Open 

Contact” alarms, (i.e. the contacts open to indicate an alarm condition). In the event that 

an open input occurs on any Digital Input, and the Alarm box is checked, the system will 

trigger the Global Alarm. In this state, Digital Outputs DO3 – DO7 will be turned off and 

disabled, putting valve actuators in a cut-off state. The system will stay suspended in this 

cut-off state until the input generating the alarm is once again closed (alarm condition 

cleared). 

 

DO (Digital Output) Status. 

 

This section displays the status of all digital outputs as indicated by the associated LED. 

The digital outputs are configured as 24V DC signals that operate a variety of valves and 

relays from the External Interface board. When the analyzer is running, these outputs 
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automatically turn on and off as required by timed events and calibration settings. For 

troubleshooting purpose these outputs can be manually turned on and off, only if the 

analyses have stopped, no Alarm conditions exist, and the Analyzer is in “holding” state. 

 

 

Section 2.2.6 Output Settings  
 

The Output Settings screen allows the user to select the desired variable and scaling for both 

Analog Output channels available with SLA-1000 (Figure 2.18).  

 

To access this menu press Settings > Output Settings 
 

 
Figure 2.18 – Output Settings Screen 

 

The Output Settings menu is divided into two identical sections for Analog Output 1 and Analog 

Output 2. Pressing the Variable button will open a list of available parameters for the user to 

choose from (Figure 2.19). The Low Value and High Value buttons permit the input range to be 

defined, regardless of the variable selected. Pressing these buttons will open the touchscreen 

keyboard and enable modification as necessary.   
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Figure 2.19 – Output Variables Dropdown Menu 

 

The Out FS mV button allows the output range of the associated DAC to be set. The 18-bit DAC’s 

have a specified output of 0-4000mV. Although lowering this value will allow 100% of range High 

Value to be achieved at a lower output voltage, the total number of bits representing this value 

would be correspondingly reduced. In order to capitalize on all available 18-bits of resolution, 

and to satisfy the Signal Conditioner input requirement of 0-1 VDC, the circuitry incorporates a 

4:1 voltage divider built into the SP-2000 signal processing detector board. Therefore, even 

though the Out FS mV is set to 4000mV, the resulting DAC analog voltage output is reduced to 

1000mV at this setting.  

 

The Out % FS Line will always indicate the current variable value relative to the variable range in 

percent full scale.  

 

 

Section 2.2.7 Purge Override 
  
The SLA-1000 has been certified for use in Class 1, Division 2 hazardous locations and purge 
pressure is necessary for maintaining certification requirements (See Section 6). The analyzer 
purge is intended to maintain positive pressure on the analyzer enclosures to prevent ingress of 
potentially hazardous atmospheres. Purge monitoring of the SLA-1000 is accomplished utilizing 
the Cyclops Z-purge device. 
 



190514 ATOM SLA Manual Rev A  SLA-1000 User’s Manual 
 

SLA-1000 User’s Manual   Page | 52 

The purge override feature (Figure 2.20) is incorporated into the SLA software to permit analyzer 
operation without enclosure purge pressure. This enables the enclosure doors to be open for 
inspection or maintenance of the analyzer when the area is known to be non-hazardous. 
 
Access this mode by pressing Settings > Purge Override 
 

 
Figure 2.20 – Purge Override Menu 

 
The default time for Purge Override is 10 minutes. Pressing the Start button initiates the Purge 
Override function for the designated time. The time at the bottom of the menu reflects time 
remaining before the Purge Override function is disabled. 
 
Should a different Purge Override time be desired, pressing the Minutes button will open an 
Enter Value window that allows the user change the Purge Override time up to 1,092 minutes, 
or just over 18 hours. Should more time than the originally entered time be necessary, the user 
may enter a new value at any time. Pressing the Off button will revert back to normal operation, 
but Purge Override should only be stopped after the enclosure doors have been closed and purge 
is reestablished to avoid shutdown of furnace and Run Cycles. 
  
 

Section 2.2.8 System Settings 
 

The System Settings menu allows the user to configure WARNINGS and ALARMS for the SLA-
1000. To access this menu press Settings > System Settings 
 
The System parameters are arranged in three groups. The upper group consists of seven digital 
inputs (DIs) that monitor status of critical and user-selected parameters.  DI1 – DI3 are pre- 
assigned, while DI4 – DI7 are user-programmable. The pre-assigned parameters, DI1 – DI3 are 
considered system- critical conditions and are configured by default for ALARM.  The DI4 – DI7 
parameters are unassigned and can be utilized as a customer configurable digital inputs to either 
ALARM or WARN (Figure 2.21). 
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Figure 2.21 – System Settings Screen 

 
The designated trip points for the system critical parameters are as follows: 
  

Parameter Trip Condition 

(DI1) Loss of Purge Enclosure Pressure Falls below 0.2” H2O pressure 

(DI2) O2 Pressure - Stop Zero Air Used for Combustion less than 20 PSIG 

(DI3) Furnace Temp Low Combustion Furnace Temperature less than 1025°C  

 
The middle group monitors reported Zero, Span, Stream1 and Stream2 values. These parameters 
allow the user to select both Low Alarm and High Alarm limit settings by entering the desired 
value in ppm after pressing the associated button. The most recent reported values are displayed 
between the High/Low limit settings for reference. These parameters are not system critical and 
can be programmed to WARN only.  These are designed to provide indications of 
process/calibration upsets so that the upset can be tracked and corrective action taken.  This 
would not be possible if the analyses were stopped in the event of a process upset. 
 
The last group monitors the reported Temperature and Mass Flow controller values. These 
parameters also allow the user to select both Low Alarm and High Alarm limit settings by entering 
the desired value. The most recent reported values are displayed between the High/Low limit 
settings for reference. These parameters can be programmed to either WARN or ALARM.   
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NOTE: The values used for alarm triggers in the Zero, Span and Stream sections 
are averaged values. To modify the number of runs in the Zero and Span average, 
please refer to section 2.2.2, for the Stream average, please refer to section 2.3.3. 

 
Alarm 
 

If the ALARM status is enabled for any parameter, and that parameter falls out of its 
designated range, the SLA-1000 will trigger an alarm that will be indicated by a red LED in 
the State column (Figure 2.22). 

 

 
Figure 2.22 – Loss of Purge Alarm 

 
Any ALARM state will be reflected by the Analyzer Alarm Status line at the bottom of the 
System Control section of the Home Screen (Figure 2.10). The message ALARM!, will also 
be prominently flash on the Main Menu bar in bold red text (Figure 2.23).  
 

 
Figure 2.23 – Main Menu Alarm 

 
As soon as an ALARM state is triggered (except DI1 – DI3*), the analyzer is designed to 
immediately stop analyses. In addition, the GLOBAL ALARM relay will be activated. Run 
Cycles will automatically resume as soon as all alarm conditions are cleared, and after any 
programmed Purge time has elapsed. This also means that all alarm conditions must be 
clear before any Run Cycles can be started. 
  

* NOTE: DI1 (Loss of Purge), DI2 (O2 Pressure - Stop) and DI3 (Furnace 
Temperature Low) are system critical parameters and cannot be disabled.  In the 
event of any of these Alarm conditions, the analyses will stop immediately as well 
as the furnace will be turned OFF.  The Analyzer will not begin analyses until ALL 
three of these alarms are cleared in addition to any other alarm conditions. 

 
Warning 
 

If the WARN status is enabled for any parameter and that parameter falls out of its 
designated range, the SLA-1000 will trigger a warning that will be indicated by a yellow 
LED in the State column. Similar to ALARM status, the Warning will be also be reflected 
by the Analyzer Warn Status in the System Control section of the Home Screen, as well  
prominently flash on the Main Menu bar (Figure 2.24).  
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Figure 2.24 – Main Menu Warning 

 
Any parameter enabled to generate a WARN status, should it fall outside the designated 
range, is not considered to be a critical parameter for system operation. It is primarily 
intended to alert the user to a condition that may require intervention. Run Cycles will 
not be stopped when a WARN condition exists. 

 
NOTE: To disable the alarm or warning monitoring, uncheck the respective box 
until the parameter is to be monitored again. 

 

 

Section 2.2.9 Timed Event Settings  
 

The Timed Event Settings menu allows the user to configure all timing functions associated with 
the Run Cycle (Figure 2.25). To access this menu press Settings > Timed Events.  
 

 
Figure 2.25 – Timed Event Settings Screen 

 

The Timed Events Settings menu contains 6 separate Cycle Timed Events. These events are 

defined by 10 programmed timing entries that stipulate Run Cycle control and operation.  
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Timed Events within this menu include:  

 

Event Name Description 

Inj Start Sample Valve is turned ON to Inject Sample in Loop 

Inj Stop Sample Valve is turned OFF to Reload Sample Loop 

SSO/ARV Start Sample Shut Off turned ON relieving Excess Pressure to Atmospheric Reference Vent 

SSO/ARV Stop Sample Shut Off turned OFF returning Normal Sample Flow through Inject Valve 

Auto Zero Sets Time when Auto Zero of Baseline is Performed (Setting of 0 = Off) 

BL Start Initiation of Baseline Evaluation Period; Values Averaged Establishing BL Value. 

BL Stop Completion of Baseline Evaluation; BL Average used to Correct Area Count Readings 

Peak Start Initiation of Peak Integration Period; Begin Summation of BL Corrected Readings 

Peak Stop Completion of Peak Integration Period; Sum All Data to Generate Peak Area Value 

Cycle Secs Sets Cycle duration and Defines completion of the Cycle Time. 
 

To change the timing entry for any of these events, press the associated button that will open an 
Enter Value screen. The user enters the desired time in seconds and presses the OK button. 
Generally speaking, all settings provided in the Timed Events menu by the factory have already 
been optimized for best analyzer performance. Although the user is at liberty to make changes 
to these settings, analyzer performance cannot be guaranteed whenever factory settings have 
been modified from their original values.  
 
NOTE: A value of zero (0) in the Timed Events Settings will turn off the event  
 
 
 
 

Section 2.3 View 
 

The View menu group contains submenus that provide information regarding instrument 
performance, but does not contain any settings related to instrument operation. (Figure 2.26) 
 

 
Figure 2.26 – View Dropdown Menu 
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Section 2.3.1 Historical Calibration Results  
 
The Historical Calibration Results menu allows the user to review previous calibration results that 
were archived by pressing the Calibrate and Save button in the Calibration Settings menu (Figure 
2.27). To access this menu press View > Historical Calibration Results. 
 

 
Figure 2.27 – Historical Calibration Results Screen 

 

The menu is similar to the Check Calibration Results menu, but with supplemental information. 

The top line shows the date and time the displayed calibration information was saved. Pressing 

the down arrow located on the far right of the Date/Time Bar opens a list of all previously saved 

calibration results.  
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The user can scroll through the list to select the desired calibration date, and then press OK to 

view the prior calibration results (Figure 2.28). 

 

 
Figure 2.28 – Historical Calibration Results Dropdown Menu 

 

The central section provides individual peak areas and concentrations, as well as the average of 

all completed cycles run. The Value Used section contains the final values selected for use. In 

other words, even though the analyzer computes the average area for Check Zero and Check 

Span concentrations in the Check Calibration process, the user may have used an alternate value 

for computing the “Calculated and Used” RF. User modification of these values will be evident if 

there is a difference between Average values and “Value Used”. 
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Section 2.3.2 Cycle Graph Mode  
 
The Cycle Graph menu is a graphical representation of the detector signal as it occurs in real time 

during the Run Cycle. This screen allows the user to ascertain general characteristics such as 

baseline noise, peak profile and peak integration period from one or more sequential analysis 

(Figure 2.29). 

To access the Cycle Graph Screen press, View > Cycle Graph Mode and choose the parameter of 
interest to display its graph. 
 

 
Figure 2.29 – Cycle Graph Mode Screen for Stream 1 

 
Cycle Graph  
 

The Cycle Graph is a typical X-Y graphical display plotting detector counts versus time in 
seconds. Individual data points are computed and plotted for each second of the 
programmed cycle time. 
 
The graph also displays the Start and Stop time of the Peak Integration Window as 
denoted by the two vertical red lines. The software is designed to sum all baseline 
corrected areas within this window, or between 20 and 70 seconds in this example.  
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A feature only available when one series is selected for plotting in Display Cycles is a 
vertical line cursor with an associated text box. The user may press anywhere within the 
plot area to activate this cursor, causing an X-Y text box to appear. The user may move 
the cursor anywhere along the signal to display the time-counts values of the nearest data 
point. The text box will not appear until there is recorded data within the current Run 
Cycle (Figure 2.30). 
 

 
Figure 2.30 – Viewing Specific Data Points on Cycle Graph 

 
Set Min and Set Max 
 

These buttons allow the user to change the minimum and maximum scaling of the Cycle 
Graph. The scaling feature enables significant flexibility of the displayed data, depending 
on user preference.  

 
Display Cycles  
 

This button allows the number of cycles to be displayed as series, allowing graphical 
comparison of previous Run Cycles. Any number of sequential analyses may be chosen 
which are represented as Series 1-7 on the right side of the Cycle Graph.  
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The Series colors have been selected to convey temporal information related to the Run 
Cycle in the order in which the analyses occurred. The series colors are as follows: 

 

Series 1 Red  

Series 2 Orange  

Series 3 Yellow  

Series 4 Green  

Series 5 Light Blue  

Series 6 Dark Blue  

Series 7 Purple  

 
 
The most recent series will always be red. As additional cycles are run, the color for the displayed 
series are scrolled such that the data represented by a particular color is always shifted to the 
next Series color at the beginning of a new cycle (Figure 2.31). 
 

 
Figure 2.31 – Cycle Graph Displaying Multiple Trace Concentration Peaks 

 
NOTE: If there is more than one series selected to be graphed, the previously described vertical 
cursor displaying the time and detector counts is disabled. 
 
Current Value  
 
 This shows the current value as it rises and falls throughout the cycle period. 
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Current Cycle Time 
This is the same number that is displayed on the Home Screen and shows the current cycle 
time for convenience.  

 

 

Section 2.3.3 Process Results  
 

The Process Results menu screen allows the user to view analysis results in percent concentration 
of completed process samples run (Figure 2.32). 
 
Open this screen by pressing View > Process Results. 
 

 
Figure 2.32 – Process Results Screen for Stream 1 and Stream 2 

 
The Process Results menu screen displays a list of the last 10 samples run. The most recent 
sample is listed at the top and results will scroll down as subsequent samples are run.  
 
The average concentration is displayed at the bottom of the table and includes the selected 
number of most recent runs. To select the number of runs included in the average, press the 
button adjacent to “Conc. Average” to open a select text box. 
 
NOTE: If concentration is chosen as an output of the analyzer, the average concentration 
calculated above is outputted. To output the concentration for each single run (as displayed on 
the home screen), select a Conc. Average of 1. 
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Section 2.4 Windows 
 
The Windows menu screens allow the user to organize any open menus (Figure 2.33).  
 

 
Figure 2.33 – Windows Dropdown Menu 

 

Due to the relatively large size of the available menus in relation to the size of the SLA-1000 
touchscreen computer display, the only practical arrangement option is to cascade open 
windows. The Cascade function stacks menu screens utilizing the title bar for reference in the 
order they were opened. Selecting either Arrange All or Cascade options generates identical 
arrangement of menu screens, such as in the example below. (Figure 2.34) 
 

 

 
Figure 2.34 – Cascaded Menus 
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Section 2.5 Help 
 

The Help section contains a single drop down selection menu (Figure 2.35). 

 

Figure 2.35 – Help Dropdown Menu 
 

 

To access the About Us menu press Help > About Us (Figure 2.36). 
 

 
Figure 2.36 – About Us Screen 

 
The About Us Menu Screen displays information regarding the software version and associated 
release dates of three separate programs. The GUI, Detector and Scanner programs have distinct 
functions, but work in conjunction with each other to provide comprehensive control of the SLA-
1000 instrument and user interface.  
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Section 3 – Basic Maintenance Guide 
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Section 3.1 Combustion Tube Replacement 
 

 

In order to replace the combustion tube, the transfer tube must be removed first.  Start by 

removing the above-indicated nuts on the sample valve and sample enclosure bulkhead to 

enable complete removal of the transfer tube. 

 

 

Undo the nut on the bulkhead in the furnace enclosure as indicated above. 
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Once it is loose, push the combustion tube to the right so that the nut and tubing separates 

from the enclosure wall which will allow the furnace to swing free.  

 

 

Undo the nut on the combustion tube. 
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Remove the short tubing that connects the combustion tube to the bulkhead. 

 

 

Loosen the two screws indicated above inside the furnace chamber. 
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Gently swing the furnace outward. The furnace incorporates a special roller bearing for support 

and allows near effortless movement. 

 

 

Loosen and detach combustion tube outlet fittings. 
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Above picture shows all fittings detached from the combustion tube. 

 

 

Press and rotate the insulator clamp to allow access to the ceramic insulators. 
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Carefully remove both ceramic insulators. The combustion tube is now ready to be removed 

 

 

Carefully and slowly remove the combustion tube from the furnace. 

Insert a new combustion tube, replace ceramic insulators, rotate and secure insulator clamp. 

Re-attach combustion tube fittings, carefully roll furnace back in place and retighten screws.  
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Section 3.2 Furnace Replacement  
 

In order to replace the furnace, the transfer tube and the combustion tube must be removed 

first.  Follow the procedure in Section 3.1 Combustion Tube Replacement until you remove the 

combustion tube.  Once the combustion tube is removed, continue with the remaining 

procedure to replace the furnace as explained below. 

 

Using a small screwdriver to compress the terminal spring, remove both heater wires 
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Heater wires removed from terminals 

 

 

 

Repeat the above and remove both thermocouple wires from the terminals 
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Carefully lift the furnace up off of the pin hinges and remove from the furnace chamber 

 

 

Remove all four furnace mount screws to complete the disassembly process.   

 

 

 

Follow the process in reverse order to install a new furnace and re-wire it. 
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Section 3.3 Membrane Dryer Replacement 
 

Orient the permeation tube fitting as shown 

 

 

 

Begin by placing the tubing inside of the mounting bracket 
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Continue winding, stacking the dryer layer upon layer 

 

 

 

 

Until dryer has been completely wound 
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After winding, the Perma Pure Dryer should look like this 

 

 

 

Next, lift tubing to push the first fitting back inside  

 

 

 



190514 ATOM SLA Manual Rev A  SLA-1000 User’s Manual 
 

SLA-1000 User’s Manual   Page | 78 

Then bring to the top against the mounting bracket 

 

 

 

Using a 7/16” wrench, loosen and remove the 1/8” fittings on both ends 
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The dryer should look like this after both end fittings are removed 

 

 

 

Next, loosen but do not remove the ¼” inch fitting on both ends 
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Holding the inner tube, rotate the T-fitting to point toward the inside on both ends 

 

 

 

The dryer should then look like this 
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Re-tighten both ¼”T-fittings 

 

 

 

Lastly, re-attach both 1/8” inch end fittings  

 

The Membrane dryer is now ready to be reinstalled on the analyzer. 
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Section 3.4 Transfer Tube Replacement 
 

The transfer tube is the part of the analyzer that carries the liquid sample into the combustion 
chamber. Over time, some applications require the transfer tube to be changed as a coke deposit 
forms on the walls of the transfer tube which impede proper sulfur measurement. 
 
Start by removing the indicated nuts (Figure 3.1) to enable complete removal of the transfer 
tube. 
Remove the fittings from the used sample transfer tube to install them on the replacement 
sample transfer tube as indicated in the following pictures. 
 
 

 
Figure 3.1 - Disconnect nuts for the Transfer Tube 
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Once the new sample transfer tube is ready for installation (fittings properly inserted on the 

transfer tube), carefully insert it back into the fitting of the sample enclosure from which it was 
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first removed. The depth of the transfer tube inside the combustion chamber is application 

dependent. Please, verify transfer tube position before and during tightening of the fittings. As a 

rule of thumb: 

 

Fluid Insertion Depth Guideline Viscosity 
(cSt) at room 
temperature 

Gasoline At opening <1  

Diesel ¼” 1-5 

Light Gas Oil ½” 5-20 

Heavy Gas Oil 1” >20 

 

Figure 3.2 below shows the inserted transfer tube with the arrow pointing to the approximate 
transfer tube depth for Gasoline product streams. 
 

 
Figure 3.2 - Transfer Tube insertion depth 
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Once the transfer tube is inserted at the right depth in the combustion tube, tighten the fittings 

in the sample enclosure.  

Note: Do not over tighten fittings as they could suffer damage and prevent proper future 

replacement of the transfer tube. Start by hand-tightening the fittings and finish with ¼ turn of 

wrench. 
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Section 3.5 Shinko Temperature Controllers  
 

The SLA-1000 has three separate temperature zones controlled by Shinko Model DCL-33A 
temperature controllers, which include the Sample Enclosure, Combustion Furnace and Main 
Enclosure. These DIN rail mounted controllers are located in the center of the Main Enclosure, 
and underneath the right-hand side of the detector module. (Figure 3.3)  
 

 
Figure 3.3 – Shinko Temperature Controllers 

 
Factory recommended temperature set-points are as follows: 
 
1. Sample Enclosure: 70°C (or sufficient to prevent any condensation of sample) 
2. Combustion Furnace: 1050°C (minimum for complete sample combustion and Sulfur 

conversion) 
3. Main Enclosure: 30°C (may be increased to 40°C if necessary in colder 

environments) 
 
The temperature controller settings have been programmed into the instrument installed 
controllers at the factory and are included in this manual for reference purposes only. The 
following page contains factory settings for the three Model DCL-33A Temperature Controllers 
for the SLA-1000. (Section 3.5.1) 
 

For complete instructions and menu navigation for the parameters below, refer to the Shinko 
DCL-33A Indicating Controller Instruction Manual. 
 

Note: Although auto-tuning is a routine function which is part of analyzer testing at the factory, 
it is recommended that subsequent auto-tuning of these controllers is performed in the field for 
best results.  
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Section 3.5.1 Shinko Temperature Controller Programmed Settings  
 

  

Press to 
change Desired 
Value 

Press the 
key while 
holding down 
the  key. 

Press the   
key to navigate 
to the next 
menu item.       

Press the key 
for approx. 3 sec 
while holding 
down the  key. 

Press the   key 
to navigate to the 
next menu item. 

Press the  
key for approx. 
3 sec while 
holding down 
the  key.  

Press the   
key to navigate 
to the next 
menu item. 
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Section 3.6 Shinko Signal Conditioners 
 

The SLA-1000 has two analog outputs that utilize Shinko, Model SAU-1 DIN rail mounted Signal 

Conditioners. These modules have been configured to deliver a 4-20mA output, with a 0-1VDC 

input signal. These controllers are located in the center of the Main Enclosure, to the left of the 

three temperature controllers (Figure 3.4).  

 

The intended analyzer variable for the controller input is selected from the Output Settings of 

the SLA analyzer software utilizing the computer touchscreen. The variable can then be ranged 

within the same menu as desired, which will deliver the 0-1VDC signal from the SP-2000 Signal 

Processing Detector board DAC to the Shinko Signal Conditioner input. (Section 3.6.1) 

 

 

 
Figure 3.4 – Shinko Signal Conditioners 

 

The two Signal Conditioning Modules have been programmed by the factory for the following: 

 

  Input  Output  Reading 

 

Channel A: 0-1VDC 4-20mA  0-999.9 (ppm when Stream 1 Conc. is the variable) 

Channel B: 0-1VDC 4-20mA 0-999.9 (ppm when Stream 2 Conc. is the variable) 
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Section 3.6.1 Shinko Signal Conditioner Programmed Settings 
 

 

 

 

   

Press the   key for approx. 3 
sec while holding down the  

 (blank) key.  Press the   
key to navigate to the next 
menu item. 

Hold down the   key for 

approx. 3 sec.  Press the   
key to navigate to the next 
menu item.  Hold down the 

  key for approx. 3 sec to 
exit the menu.  
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Section 3.7 Updating Software 
 

The SLA-1000 computer software and detector firmware are easily upgraded as revisions become 

available from the factory. The GUI and scanner software reside on the solid-state hard drive of 

the touchscreen computer. The detector firmware can be upgraded utilizing what is known as a 

bootloader program, which is accessible from the program icon located on the desktop. Future 

updates may include changes to any, or all embedded programs. Instructions for how to load and 

update the SLA-1000 software to include the latest released revisions are included below. 

 

 

Section 3.7.1 Installing the GUI and Scanner software using the installer program 

 

STEP 1: INITIAL SETUP 

 
1. Stop the analysis/cycle (if running) 

 
2. Settings backup:  On the GUI program take screen-shots (or manually write down 

information) of the following screens.  This can be used to manually re-enter the original 
settings in the event the data gets erased during software installation. 
 
Settings    Home 
   Calibrate Settings 
   Detector Settings 
   System Settings 
   Timed Events Settings 
 
 

3. Close the GUI program (Figure 3.5). 
 

 
Figure 3.5 

 
 

4. Close the main Atom program (Figure 3.6). 
 

 
Figure 3.6 
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STEP 2: INSTALLING THE REDISTRIBUTABLES 
 

1. Double-click on the “ATOM_SLA_Redist_Vxxx(A2).exe” file. 
Installer Version 

 
2. On the start screen that comes up, click on “Next” (Figure 3.7). 

 

 
Figure 3.7 

 
3. Leave all options “checked”, and click Install (Figure 3.8). 

 

 
Figure 3.8 
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4. The installation process will begin (no user intervention is necessary) (Figure 3.9). 
 

 
Figure 3.9 

 
 

5. Once the installation is complete (~ 5 - 10 mins), and when prompted, click “Close” 
(Figure 3.10). 

 

 
Figure 3.10 

 
 
This completes the installation of the .NET framework and the SQL Server. 
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STEP 3: INSTALLING THE GUI 
 

1. Double-click on the “ATOM_SLA_GUI_Vxxx(A2).exe” file. 
       Installer Version 

 
 

2. On the start screen that comes up, click Next (Figure 3.11) 
 

 
Figure 3.11 

 
 

3. Leave all options “checked”, and click Install (Figure 3.12) 
 

 
Figure 3.12 
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4. Once the installation is complete (~ 1 - 2 mins), click Close (Figure 3.13) 
 

 
Figure 3.13 

 
 
This procedure copies all the updated files into the “C:\ATOM!\” and “C:\ATOM_GUI\” 
directories.   
The updated .HEX file, which needs to be loaded onto the Detector board, is also copied into 
the “C:\ATOM!\” directory.   
 
The following section explains the procedure to load this .HEX file onto the Detector board. 
 

 

Section 3.7.2 Bootloader Procedure for Detector Board 

  
This procedure replaces the embedded HEX file firmware program in the SP-2000 Signal 

Processing detector board microprocessor. This file must be installed separately as it cannot load 

automatically without accessing and utilizing the Microchip bootloader program per the 

following instructions below. 

 

1. Open the bootloader software by double-clicking on the “AN1310ui” shortcut on the PC 
Desktop (Figure 3.14).    
 

 
Figure 3.14 
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2. Press the green Run Mode button on the bootloader screen (Figure 3.15). At the bottom 
right hand side of the screen the “Connected” status will appear as well as the COM 
Port number. 

 

 
Figure 3.15 
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3. Press the blue Break/Reset Mode button (Figure 3.16). The bottom status bar will 
request resetting the SP-2000 board. 

 

 
Figure 3.16 
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4. On the SP-2000 board inside the main analyzer enclosure (Figure 3.17), press and hold 
the Reset button for 2 seconds. The SP-2000 board is located immediately behind the 
Detector assembly. 

 
IMPORTANT…… you only have 30 seconds to press the “Reset” button before the communication 

“Times Out”.  If the connection times out, re-start from beginning of this 
procedure. 

 
 

 
Figure 3.17 

 
 

  



190514 ATOM SLA Manual Rev A  SLA-1000 User’s Manual 
 

SLA-1000 User’s Manual   Page | 99 

5. Press the red Break Mode button (Figure 3.18). 
 

 
Figure 3.18 

 
 

6. From the main menu select File>Open (Figure 3.19) 
 

 
Figure 3.19 
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7. Select the SGA-detector.production.hex file located in C:\ATOM! directory and click 
Open (Figure 3.20). (The detector HEX file is same for both SGA and SLA applications) 

 

 
Figure 3.20 

 
8. The bootloader screen will show new hexadecimal values. Click the Write Device button 

(Figure 3.21). 
 

 
Figure 3.21 
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9. The bootloader software will replace the old firmware in the SP-2000 board with the 
new one. The bottom status bar will indicate “Write complete” when this step is 
completed (Figure 3.22). 

 

 
Figure 3.22 

 
10. Close the bootloader software (Figure 3.23). 

 

 
Figure 3.23 
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11. Press and hold the Reset button on the SP-2000 board for 2 seconds to complete this 
procedure. 

 

12. Restart the computer, and both the ATOM and the GUI programs will automatically start 
up. 

 
Once the GUI is up and running, verify that all the settings on the Calibrate, Detector, 
System, and Timed Events Settings have been preserved.  If not, manually enter these 
settings before re-starting the analysis. 
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Section 4 – SLA-1000 MODBUS Digital Communications  
 

Section 4.1 Customer Connections 
 
The SLA-1000 System supports both RS485 half-duplex and RS422 full-duplex communication for 

client access to the ATOM Database. User communications cable should be connected as 

specified below, depending upon COM type. 

The COM 4 Port on the touchscreen computer which includes a DB-9 connector and associated 

label with communication signals is assigned to the following Pins: 

 RS-485 RS-422 

1 TX- X X 

2 TX+ X X 

3 RX-  X 

4 RX+  X 

5 GND X X 

 

The DB-9 pins are connected to a terminal strip within the SLA-1000 Main Electronics Enclosure. 

Locate the User Connection Terminal Strip within the SLA cabinet 

 

 

For MODBUS RS-485: Connect to terminals 1, 2, 5 
 
For MODBUS RS-422: Connect to terminals 1, 2, 3, 4, 5 
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Section 4.2 Communication Settings 
 
There are two sets of communication parameters displayed on the ATOM program, the Detector 

and Client communications.   

 

 
          Detector comm                        Client comm 
 
 

The Detector communication settings are intrinsic to communication between the Detector PC 

board and the ATOM program, and the Client communication settings are intrinsic to 

communication between the DCS / PLC and the ATOM program.  These settings can be modified 

by editing the Atom.exe.config file. 

 

 

 

In addition to the communication settings, the “Msg” (message) counters when incrementing 

give a real-time indication of active communication between the respective modules.  If either of 

the message counter is passive, it is an indication that communication has either been lost or 

aborted and user intervention may be required to restore it.  

 

Note:  the above communication settings are crucial for operation and any modifications 

could lead to Analyzer operation failure.  Please contact ATOM Instrument if you 

need more information about modifying these settings.  The only recommended 

setting change is the “Analyzer Slave ID”, and is explained in the following section 

(typically required ONLY if setting up DCS communication with multiple ATOM 

Analyzers). 
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Setting up Analyzer Slave ID for communication with the DCS/PLC: 
 

The Analyzer Slave ID setting can be programmed by editing the Atom2.exe.config file  
(Figure 4.1).  
Navigate to the Atom2.exe.config file located in C:\ATOM!\ directory.  Right-click on the file and 
when the selection menu opens, select “Open with..” and choose the Notepad program to edit 
the config file. 
When the file opens in Notepad, locate the <add key=”ID_Slave” value=”2”> setting as shown in 
Figure 4.1.  This value is the unique ID that identifies each analyzer on the network to the DCS.  
Change the value to a desired number, then click on “File  Save”, and the n Exit the program. 
Start the ATOM programs by double-clicking on the “Atom SLA Vxxx(A2)” desktop shortcut – 
this will automatically start both the ATOM and GUI programs. 
 

 
Figure 4.1 – Atom.exe.config File  
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If the ATOM successfully establishes communication with the DCS, the message counter on the 

right hand side of the ATOM program (as shown in Figure 4.2 below) will start incrementing. 

 

  
Figure 4.2 – ATOM communication messages  

 

If the ATOM and the DCS are not communicating, the message counter will either read “0”, or 

will not increment. 
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Section 4.3 MODBUS Function Code Description 
 

The ATOM SLA-1000 is a “MODBUS Slave” while the client is the “MOSBUS Master”. All commands 

supported are 8-byte length as described below: 

 

|Address ID| Function code |Start Ho|Start Lo|Data #pts Ho|Data #pts Lo|CRC0|CRC1| 
 
Where: 

 Address ID is the address that the station ID ATOM software must find to start a message. 

 Function code is a value 1 to 6 declaring what function is to be performed (see below). 

 Start HO is the starting register higher order 8-bits. Start LO is the starting register lower order 
8-bits.These two bytes are concatenated to create a 16-bit number used in the data base. 

 Data #pts Ho and Data #pts Lo are two bytes concatenated to specify the number of registers 
designated in the MODBUS message. 

 CRC0 and CRC1 are two bytes concatenated to specify the CRC of the MODBUS message. 
Security is maintained by computing the CRC of the message first six bytes and comparing to the 
last two bytes for a match. A message is not processed if the two CRC’s do not match. 

 

 Function code 1: Read Relay coils (R1-R32 range). 

 Function code 2: Read Input Status Registers (R10001-R10032 range). 

 Function code 3: Read discrete 16-bit holding Registers (R40001-R40040 range). 

 Function code 3: Read discrete 32-bit holding Registers (R40041-R40120 range) where: R40041-
42 is the first par, R40119-120 is the last pair. 

 Function code 4: Read output 32-bit register pairs (R3001-R30082 range) where: R30001-02 is 
first pair, R30081-R30082 is last pair. 

 Function code 4: Read output 16-bit registers (R30083-R30120 range) where: range is 16-bit 
registers. 

 Function code 5: set relay coil register (R1-R40). 

 Function code 6: preset single holding register (R40001-R40120). 
 
The double registers specified in function code 3 and 4 must be recognized as 32-bit data to interpret it 
properly. 
 

Section 4.4 Reading Algorithm 
 

The MODBUS data is typically a near continuous stream of data packets from the Client. The ATOM 

software is self-aligning regardless of where it starts listening to packets. This is accomplished by starting 

with an index of zero. The byte read must equal the Station ID if the index is zero. If not, the alignment 

procedure begins again without incrementing the index. Alignment is achieved within 8 characters of a 

packet for the ATOM SLA-1000. When a character read does equal the ID, the index is advanced from 0 to 

1. The next character read must equal an allowable function code (1-6). If there is no match the index is 

reset to 0. Under this scenario, the reception of packets will self-synchronize. If we have a match on the 

first and second byte, read the next 6 bytes. At this point we have 8 bytes in a receive register. Perform a 

CRC on the first six characters and compare with the 7th and 8th characters. There must be a CRC match to 

process the received packet. If there is no match, the index is again reset to 0 and the process of data 
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capture and qualification repeats. Upon detection of a complete and valid packet the received 8-byte 

packet is transferred to private processing area. The “Save Packet” function is called which executes a 

function (1-6) as defined by the function code byte in the 2nd byte of the saved packet. The ATOM software 

creates a reply message for the Client and transmits it back to the client. A message stream resembles the 

image below showing the command on the left and the response on the right. 

 

 

Response time is approximately 10ms after the packet is decoded before a reply message is sent. 

 

Example of reading a single unsigned 32-bit register 
 

In the example below, registers pair R30169 and R30170 are the ppm value. Use function code 4 with an 

offset of 68 in the MODBUS message to read it. 

 

Example MODBUS query:  02 04 00 44 00 02 31 ED 

 

Where: 

02 = ID 

04 = Function Code 

00 44 = address offset = 68 

00 02 = number of registers requested 

31 ED = CRC 

 

Example of MODBUS response, returns 4 bytes from offset 68: 02 04 04 00 07 B1 84 0D 76 

 

Where: 

02 = ID 

04 = Function Code 

04 = Byte Count 

00 07 B1 84 = 504,196 ppm 

0D 76 = CRC 
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Section 4.5 ATOM Instrument SLA-1000 MODBUS Map  
 

The MODBUS Data Model presents six database areas that SLA1000 data may be read from or written to. 

The areas are defined as follows: 

ATOM MODBUS Database Model 

Database Area Name Register Designation Default Data Type 

1 Coils/Boolean 00001 – 00064 Boolean 

2 Input Status 10001 – 10080 Boolean 

3 Input Register pairs 30001 – 30080 32-bit Integer 

4 Input Register 30081 – 30120 16-bit Integer 

5 Input Register 30121 – 30342 32-bit Integer 

6 Holding Register 40001 – 40080 16-bit Integer 

7 Holding Register pairs 40081 – 40240 32-bit Integer 

 

Each discrete data element within the MODBUS database is called a register. Register addressing resolves 

the database area in which it resides as well as the element offset within the area. For example, the 

register address of 30083 indicates the integer value stored in register 83 within the Input Registers data 

base area. MODBUS address 00004 indicates the current Boolean value in register 4 of the Discrete Coil 

Register area in the data base. 

 

Another aspect of the MODBUS register convention is that some registers are Read-Only from the Host 

system while other areas are Read/Write. 

 The Input Status Registers (1xxxx) and the Output Status registers (3xxxx) are Read-Only registers. 
The Host system is only able to read the values placed into these register areas. 

 

 The Coil Registers (0xxxx) and the Holding Register (4xxxx) are Read/Write registers. The host has 
read/write access to the registers in these areas. These areas are where Command and Operating 
Parameter values are written from the Host system. Read only data from the field unit can be 
placed into these registers as well. 

 

Registers in 3xxxx and 4xxxx range have segments dedicated for 32-bit Integers. These registers require 

two sequential 16-bit registers. See description in the map. 

This data base exists to allow communication from/to the SLA1000 to the ATOM Scanner/GUI program 

and a RS-485 link for a MODBUS client system. 

Controls at the ATOM Scanner program allow the administrator to program the COM Port, Baud Rate and 

MODBUS ID for the ATOM Scanner and the RS485 Client link.  

Client Access: Although the entire ATOM database is available, a client may only have interest in certain 

data areas. Here is a selection of typical monitor points. 
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10003 Process State (Stream 1) 1=Process on Stream 1 (Boolean) 

10007 Validating 1=Validation in Process (Boolean) 

10008 Alarm State Alarm Status (Boolean) 

10019 Purging 1=Purging in Process (Boolean) 

10024 Calibrating 1=Calibration in Progress (Boolean) 

10025 Running 1=Status Run Mode (Boolean) 

10026 Holding S1=status IDLE (Boolean) 

10032 Fresh Data “1” indicates Fresh Data (auto cleared at the end of next 
peak acquisition (about 70 seconds has elapsed) while in 
Process state) 

30069-
30070 

Ppm (Cycle Concentration 
results ) 

concentration  in ppm this current cycle (32-bit integer) 

 

Minimal client monitoring algorithm: 

The client could read 10001-10040 (5-bytes) twice per minute for changes in system status. Registers 
30069-30070 could be read when the fresh data flag sets. At least 70 seconds elapses before “Fresh Data” 
self clears for the next cycle. 
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Discrete Coil Registers 
Range 00001-00064 
 

R# Mnemonic Description (Boolean Commands) 

1 New SRN             1=New Sequential Record Number written 

2 ARun  Start/Stop a RUN; 0=Stop, 1=Start 

3 Calibrate Check Zero Start/Stop a Calibrate Zero Function, 1=Start 

4 Calibrate Check Span Start/Stop a Calibrate Span Function, 1=Start 

5 Calibrate Validate Start/Stop a Validate Function, 1=Start 

6 Manual Zero Set 1=manually zero the baseline (Home Screen) 

7 Maintenance Analyzer 0=Online; 1=Offline 

8 Reserved  

9 Calculate RF 1=Calculate the Response Factor (RF) 

10 Override Purge Override 1=ON, 0=OFF 

11 Reserved  

12 BL_Enable 1=Base Line Enable for “Zero Baseline” 
(Detector Settings) 

13 Lamp State   Lamp On/Off Control; 0=OFF, 1=ON 

14 PMT State PMT On/Off Control; 0=OFF, 1=ON 

15 Auto Cal Enable 1=Automatic Calibrate Enable 

16 Reserved  

17 SV State DO S/V (Sample Valve) 0=OFF, 1=ON (test control 
of DO) 

18 SSO State DO SSO 0=OFF, 1=ON (test control of DO) 

19 Stream 1 State DO Process Stream 1 (test control of DO)  

20 Stream 2 State DO Process Stream 2 (test control of DO) 

21 Zero State DO Zero (test control of DO) 

22 Span State DO Span (test control of DO) 

23 Validate State DO Validate (test control of DO) 

24 Alarm State DO Alarm Status (test control of DO) 

25 Playback Control of recorded data playback 0=OFF, 
1=ON (Demo Mode) 

26 Auto Cal Event Not user programmable – internal use 

27 Reserved  

28 Reserved  

29 Cal Parm Change Is set to “1” if any Cal parameters have been 
modified – internal use 

30 Save RF Saves the new calculated RF 

31 Reserved  

32 Check Sum Request Set to “1” to request Checksum from ATOM  

33 Stream 1 Enable 1=Stream1 selected (Home Screen Checkbox) 

34 Stream 2 Enable 1=Stream2 selected (Home Screen Checkbox)  

35 Reserved  

36 Reserved  

37 Thermocouple Warn Not user programmable – internal use 

38 TC1 Set Point Changed Not user programmable – internal use 
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39 TC2 Set Point Changed Not user programmable – internal use 

40 TC3 Set Point Changed Not user programmable – internal use 

41 MFC1 Set Point Changed Not user programmable – internal use 

42 MFC2 Set Point Changed Not user programmable – internal use 

43 MFC3 Set Point Changed Not user programmable – internal use 

44 Enable/Disable TC2 algorithm 0=Disable, 1=Enable – internal use 

45 Disable/Enable PD Correction 
algorithm 

1=Disable, 0=Enable – internal use 

46 - 64  Reserved   
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Discrete Input Status Registers 
Range: 10001-10080 
 

R# Mnemonic Description (connected to physical outputs) 

10001 SV State Inject/Vent Valve (S/V) Status 1=inject 

10002 SSO State SSO (sample Shut Off) 1=ON, 0=OFF 

10003 Stream 1 State (Calibrate State : FGA) Calibrate / Stream 1 Status 

10004 Stream 2 State (Process State : FGA) Process / Stream 2 Status 

10005 Zero State  Zero Calibration Status 

10006 Span State  Span Calibration Status 

10007 Validate State  Validate Calibration Status 

10008 Alarm State Global Alarm Status 0= Alarm, 1=NO Alarm 

 
 

R# Mnemonic Description (8 bits mapped to physical 
inputs) 

10009 DI1 Digital Input 1 – Loss of Purge 

10010 DI2 Digital Input 2 – O2 Pressure Low 

10011 DI3 Digital Input 3 – Furnace Temp Low 

10012 DI4 Digital Input 4 – user programmable 

10013 DI5 Digital Input 5 – user programmable 

10014 DI6 Digital Input 6 – user programmable 

10015 DI7 Digital Input 7 – user programmable 

10016 DI8 (D09) Read back of Purge Override state 

 
 

R# Mnemonic Description (Boolean Status) 

10017 Overriding 1=currently in Purge Override; 0=not in 
Purge Override 

10018 New Cycle Request Indicates if another cycle is in queue to run – 
for internal use 

10019 Purging 1=Purging in Progress 

10020 Check Sum Complete 0=currently performing or not yet 
performed checksum; 1=has completed a 
checksum – for internal use 

10021 BL_Corrected Data has been offset by baseline corrected 
value 

10022 Logging Logging to Data Base – for internal use 

10023 Reserved  

10024 Calibrating 1=Calibration in Progress (SGA/SLA ) 

10025 Running 1=In Run Mode 

10026 Holding 1=Status IDLE (“Holding” mode) 

10027 Stop Pending Indicates that Atom will go into HOLD state 
at end of current run 

10028 Injecting 1=Inject Event (sample being injected) 
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10029 Fresh Reading 1=new reading posted after computed peak 
– can be process or calibrate data 

10030 Event Base Line 1=Event Base Line acquisition 

10031 Event Peak 1=Event Peak acquisition 

10032 Fresh Data 1=Fresh Stream/Process only Data available  

10033 MFC1 Status 1=value out of range of the set lower or 
upper limits 

10034 MFC2 Status 1=value out of range of the set lower or 
upper limits 

10035 TC1 Status 1=value out of range of the set lower or 
upper limits 

10036 TC2 Status 1=value out of range of the set lower or 
upper limits 

10037 Span Status 1=value out of range of the set lower or 
upper limits 

10038 Zero Status 1=value out of range of the set lower or 
upper limits 

10039 Stream 1 Status 1=value out of range of the set lower or 
upper limits 

10040 TC3 Status 1=value out of range of the set lower or 
upper limits 

10041 Check Sum Valid 1=valid checksum; 0=error – can be used as 
a debugging tool. 

10042 Stream1FreshData 1=fresh Stream1 process data available 

10043 Stream2FreshData 1=fresh Stream2 process data available 

10044 Stream 1 State 1=currently running; 0=not currently running 

10045 Stream 2 State 1=currently running; 0=not currently running 

10046 Process State For internal use 

10047 Calibrate State For internal use 

10048 Stream 2 Status 1=value out of range of the set lower or 
upper limits 

10049 Zero Signal 1=selected and in queue 

10050 Span Signal 1=selected and in queue 

10051 Validate Signal 1=selected and in queue 

10052 User Halt Signal 1=selected and in queue 

10053 User Start Signal 1=selected and in queue 

10054 Reserved For Q Not available 

10055 Reserved For Q Not available 

10056 Reserved For Q Not available 

10057 TC2 failure 1=thermocouple has failed and analyzer has 
been stopped 

10058 MFC3 status 1=value out of range of the set lower or 
upper limits 

10059 - 80  Reserved   
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Discrete Output Registers 
Range: 30001-30342 
 

R# Mnemonic Description (32-bit RO registers) 

30001-30002 Defined Defined space for s/w use 

30003-30004 Uncorrected ppb Stream1 For internal use 

30005-30006 Uncorrected ppb Stream2 For internal use 

30007-30022 Reserved  

30023-30024 MFC3 Set point Readback Readback of set point 

30025-30026 MFC1 Set point Readback Readback of set point 

30027-30028 MFC2 Set point Readback Readback of set point 

30029-30030 TC1 Set point Readback Readback of set point 

30031-30032 TC2 Set point Readback Readback of set point 

30033-30034 TC3 Set point Readback Readback of set point 

30035-30036 MFC3 value Mass Flow Controller 3 Value 

30037-30038 Applied uV Applied Baseline offset in microvolts  

30039-30040 BL_Temp_Corrected For internal use 

30041-30042 Which Stream  Defined space for s/w use 

30043-30044 MFC1Value Mass Flow Controller 1 Value 

30045-30046 MFC2Value Mass Flow Controller 2 Value 

30047-30048 TC1 Value Temperature Controller 1 Value 

30049-30050 TC2 Value Temperature Controller 2 Value 

30051-30052 TC3 Value Temperature Controller 3 Value 

30053-30054 Reserved  

30055-30056 Reserved  

30057-30058 PMT ave PMT average (signed 32-bit) 

30059-30060 Elapse Seconds Seconds elapsed since start of current cycle 
(as seen on Home Screen)  

30061-30062 Reserved  

30063-30064 PD average Photo Diode 1 sec average 

30065-30066 Base Line Average baseline average in detector counts 

30067-30068 Area Of Peak Stream 1/Process (FGA) Stream 1 (SGA/SLA) or Process (FGA) peak 
area in detector counts 

30069-30070 CyclePPM PPM of current cycle run 
(stream/process/calibration) 

30071-30072 mV_Out PMT reading in millivolts  

30073-30074 uV_Out PMT reading in microvolts 

30075-30076 Area Of Peak Stream 2 Stream 2 peak area in detector counts 

30077-30078 DCRFDivisor Avg Lamp Intensity during baseline of latest 
cycle - For internal use 

30079-30080 Cycle_ppb PPB of current cycle run 
(stream/process/calibration) 
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R# Mnemonic Description (16-bit RO registers) 

30081 RawTC2value TC2 value before applying filter - For 
internal use 

30082 RawTC2SP TC2 set point value before applying filter - 
For internal use 

30083 Reserved  

30084 PCT_FS_DAC1 % of Full Scale for DAC1 

30085 TC77_Sensor On-board Temperature in °C (scaled) 

30086 Demo Code Value between 0-3; selects a preset 
concentration for playback 

30087 CycleNum Number of current cycle since start of 
analyses (on Home Page) 

30088 Warn States Bit definitions of WARN checkboxes on 
System Settings screen 

30089 Numbr Cycles Increments at the end of any cycle. Resets 
when analysis switches to the next zero, 
span, validate or process is started. 

30090 Alarm Status Reflected on the Home Screen, 0=no Alarm, 
1=Warning, 2=Alarm 

30091 Cycleppm (scaled) For internal use 

30092 Version Num Firmware version ID 

30093 PCT_FS_DAC2 % of Full Scale for DAC2 

30094 Date Code Days since 1-1-1900 – 32768 (s/w release) 

30095 Reserved  

30096 Override Timer Secs remaining in cabinet purge override 

30097 Numbr Cal Cycles Current calibration cycle number being run 

30098 Alarm States Bit definitions of ALARM checkboxes on 
System Settings screen  

30099 Stream 1 Progress Number of current Stream 1 cycle being run 
out of total requested 

30100 Stream 2 Progress Number of current Stream 2 cycle being run 
out of total requested 

30101 Density Reading S1 Density of Stream 1 - Value used to correct 
Stream 1 concentration (for SLA only) 

30102 Density Reading S2 Density of Stream 2 - Value used to correct 
Stream 2 concentration (for SLA only) 

30103 Alarm Hysteresis Bit definitions of ALARM checkboxes on 
System Settings screen 

30104 Warn Hysteresis Bit definitions of WARN checkboxes on 
System Settings screen 

30105 MFC3 Alarm State Bit definitions of ALARM checkboxes on 
System Settings screen (extended to 
incorporate MFC3) 

30106 MFC3 Warn State Bit definitions of WARN checkboxes on 
System Settings screen (extended to 
incorporate MFC3) 

30107-30120 Reserved  
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R# Mnemonic Description (32-bit RO registers) 

30121-30122 PA1_S2 (Stream 2-1 Area) Concentration for Stream 2 Peak Area 1 –
scrolling array of 10 concentration values in 
ppm x 100. Oldest data if the array over-
written each cycle. 

30123-30124 PA1_S2 (Stream 2-2 Area) Concentration for Stream 2 Peak Area 2 

30125-30126 PA1_S2 (Stream 2-3 Area) Concentration for Stream 2 Peak Area 3 

30127-30128 PA1_S2 (Stream 2-4 Area) Concentration for Stream 2 Peak Area 4 

30129-30130 PA1_S2 (Stream 2-5 Area) Concentration for Stream 2 Peak Area 5 

30131-30132 PA1_S2 (Stream 2-6 Area) Concentration for Stream 2 Peak Area 6 

30133-30134 PA1_S2 (Stream 2-7 Area) Concentration for Stream 2 Peak Area 7 

30135-30136 PA1_S2 (Stream 2-8 Area) Concentration for Stream 2 Peak Area 8 

30137-30138 PA1_S2 (Stream 2-9 Area) Concentration for Stream 2 Peak Area 9 

30139-30140 PA1_S2 (Stream 2-10 Area) Concentration for Stream 2 Peak Area 10 

30141-30142 PA1_S1 (Stream 1-1 Area) Concentration for Stream 1 Peak Area 1 –
scrolling array of 10 concentration values in 
ppm x 100. Oldest data if the array over-
written each cycle. 

30143-30144 PA1_S1 (Stream 1-2 Area) Concentration for Stream 1 Peak Area 2 

30145-30146 PA1_S1 (Stream 1-3 Area) Concentration for Stream 1 Peak Area 3 

30147-30148 PA1_S1 (Stream 1-4 Area) Concentration for Stream 1 Peak Area 4 

30149-30150 PA1_S1 (Stream 1-5 Area) Concentration for Stream 1 Peak Area 5 

30151-30152 PA1_S1 (Stream 1-6 Area) Concentration for Stream 1 Peak Area 6 

30153-30154 PA1_S1 (Stream 1-7 Area) Concentration for Stream 1 Peak Area 7 

30155-30156 PA1_S1 (Stream 1-8 Area) Concentration for Stream 1 Peak Area 8 

30157-30158 PA1_S1 (Stream 1-9 Area) Concentration for Stream 1 Peak Area 9 

30159-30160 PA1_S1 (Stream 1-10 Area) Concentration for Stream 1 Peak Area 10 

30161-30162 S1_Cycle_ppb Most recent Stream 1 cycle conc in ppb 

30163-30164 S2_Cycle_ppb Most recent Stream 2 cycle conc in ppb 

30165-30166 Ppb Stream 1 1 Scrolling array of 10 values with most 
recent Stream 1 concentration in ppb in 
these registers 

30167-30168 Ppb Stream 1 2 Concentration for Stream 1 ppb 2 

30169-30170 Ppb Stream 1 3 Concentration for Stream 1 ppb 3 

30171-30172 Ppb Stream 1 4 Concentration for Stream 1 ppb 4 

30173-30174 Ppb Stream 1 5 Concentration for Stream 1 ppb 5 

30175-30176 Ppb Stream 1 6 Concentration for Stream 1 ppb 6 

30177-30178 Ppb Stream 1 7 Concentration for Stream 1 ppb 7 

30179-30180 Ppb Stream 1 8 Concentration for Stream 1 ppb 8 

30181-30182 Ppb Stream 1 9 Concentration for Stream 1 ppb 9 

30183-30184 Ppb Stream 1 10 Concentration for Stream 1 ppb 10 

30185-30186 Ppb Stream 1 ave Average Concentration in ppb of preset 
numbers of cycles for Stream 1  

30187-30188 Span ppb Cal 1 Scrolling array of 10 values with most 
recent Span concentration in ppb in these 
registers 
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30189-30190 Span ppb Cal 2 Concentration for Span ppb 2 

30191-30192 Span ppb Cal 3 Concentration for Span ppb 3 

30193-30194 Span ppb Cal 4 Concentration for Span ppb 4 

30195-30196 Span ppb Cal 5 Concentration for Span ppb 5 

30197-30198 Span ppb Cal 6 Concentration for Span ppb 6 

30199-30200 Span ppb Cal 7 Concentration for Span ppb 7 

30201-30202 Span ppb Cal 8 Concentration for Span ppb 8 

30203-30204 Span ppb Cal 9 Concentration for Span ppb 9 

30205-30206 Span ppb Cal 10 Concentration for Span ppb 10 

30207-30208 Span ppb Cal ave Average Concentration in ppb of run cycles 
for Span  

30209-30210 Checksum Output of detector firmware checksum  - 
For internal use 

30211-30212 PPBA1_S2 (Stream 2 ppb) Scrolling array of 10 values with most 
recent Stream 2 concentration in ppb in 
these registers 

30213-30214 PPBA2_S2 (Stream 2 ppb) Concentration for Stream 2 ppb 2 

30215-30216 PPBA3_S2 (Stream 2 ppb) Concentration for Stream 2 ppb 3 

30217-30218 PPBA4_S2 (Stream 2 ppb) Concentration for Stream 2 ppb 4 

30219-30220 PPBA5_S2 (Stream 2 ppb) Concentration for Stream 2 ppb 5 

30221-30222 PPBA6_S2 (Stream 2 ppb) Concentration for Stream 2 ppb 6 

30223-30224 PPBA7_S2 (Stream 2 ppb) Concentration for Stream 2 ppb 7 

30225-30226 PPBA8_S2 (Stream 2 ppb) Concentration for Stream 2 ppb 8 

30227-30228 PPBA9_S2 (Stream 2 ppb) Concentration for Stream 2 ppb 9 

30229-30230 PPBA10_S2 (Stream 2 ppb) Concentration for Stream 2 ppb 10 

30231-30232 PPBave_S2 (Stream 2 ppb) Average Concentration in ppb of preset 
numbers of cycles for Stream 2  

30233-30234 Zero Area 1 Calibrate Scrolling array of 10 values with most 
recent Zero Area in these registers 

30235-30236 Zero Area 2 Zero Calibration Area 2 

30237-30238 Zero Area 3 Zero Calibration Area 3 

30239-30240 Zero Area 4 Zero Calibration Area 4 

30241-30242 Zero Area 5 Zero Calibration Area 5 

30243-30244 Zero Area 6 Zero Calibration Area 6 

30245-30246 Zero Area 7 Zero Calibration Area 7 

30247-30248 Zero Area 8 Zero Calibration Area 8 

30249-30250 Zero Area 9 Zero Calibration Area 9 

30251-30252 Zero Area 10 Zero Calibration Area 10 

30253-30254 Zero Area Ave Calibrate Avg Area of run cycles for Zero Calibration 

30255-30256 Zero ppb 1 Calibrate Scrolling array of 10 values with most 
recent Zero concentration in ppb in these 
registers 

30257-30258 Zero ppb 2 Calibrate Concentration for Zero ppb 2 

30259-30260 Zero ppb 3 Calibrate Concentration for Zero ppb 3 

30261-30262 Zero ppb 4 Calibrate Concentration for Zero ppb 4 

30263-30264 Zero ppb 5 Calibrate Concentration for Zero ppb 5 
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30265-30266 Zero ppb 6 Calibrate Concentration for Zero ppb 6 

30267-30268 Zero ppb 7 Calibrate Concentration for Zero ppb 7 

30269-30270 Zero ppb 8 Calibrate Concentration for Zero ppb 8 

30271-30272 Zero ppb 9 Calibrate Concentration for Zero ppb 9 

30273-30274 Zero ppb 10 Calibrate Concentration for Zero ppb 10 

30275-30276 Zero ppb Ave Calibrate Average Concentration in ppb of preset 
numbers of cycles for Zero  

30277-30278 Span 1 Area Calibrate Scrolling array of 10 values with most 
recent Span Area in these registers 

30279-30280 Span 2 Area Calibrate Span Calibration Area 2 

30281-30282 Span 3 Area Calibrate Span Calibration Area 3 

30283-30284 Span 4 Area Calibrate Span Calibration Area 4 

30285-30286 Span 5 Area Calibrate Span Calibration Area 5 

30287-30288 Span 6 Area Calibrate Span Calibration Area 6 

30289-30290 Span 7 Area Calibrate Span Calibration Area 7 

30291-30292 Span 8 Area Calibrate Span Calibration Area 8 

30293-30294 Span 9 Area Calibrate Span Calibration Area 9 

30295-30296 Span 10 Area Calibrate Span Calibration Area 10 

30297-30298 Span Area Ave Calibrate Avg Area of run cycles for Span calibration 

30299-30300 Validate 1 ppb Scrolling array of 10 values with most 
recent Validate concentration in ppb in 
these registers 

30301-30302 Validate 2 ppb Concentration for Validate ppb 2 

30303-30304 Validate 3 ppb Concentration for Validate ppb 3 

30305-30306 Validate 4 ppb Concentration for Validate ppb 4 

30307-30308 Validate 5 ppb Concentration for Validate ppb 5 

30309-30310 Validate 6 ppb Concentration for Validate ppb 6 

30311-30312 Validate 7 ppb Concentration for Validate ppb 7 

30313-30314 Validate 8 ppb Concentration for Validate ppb 8 

30315-30316 Validate 9 ppb Concentration for Validate ppb 9 

30317-30318 Validate 10 ppb Concentration for Validate ppb 10 

30319-30320 Validate 1 ppb Average Average Concentration in ppb of preset 
numbers of cycles for Validate 

30321-30322 Validate 1 Area Scrolling array of 10 values with most 
recent Validate Area in these registers 

30323-30324 Validate 2 Area Validate Calibration Area 2 

30325-30326 Validate 3 Area Validate Calibration Area 3 

30327-30328 Validate 4 Area Validate Calibration Area 4 

30329-30330 Validate 5 Area Validate Calibration Area 5 

30331-30332 Validate 6 Area Validate Calibration Area 6 

30333-30334 Validate 7 Area Validate Calibration Area 7 

30335-30336 Validate 8 Area Validate Calibration Area 8 

30337-30338 Validate 9 Area Validate Calibration Area 9 

30339-30340 Validate 10 Area Validate Calibration Area 10 

30341-30342 Validate Area Average Avg Area of run cycles for Validate 
calibration 
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Discrete Input Register 
Range: 40001-40240 
 

R# Mnemonic Description (16-bit RW registers) 

40001 Output Average Stream 1 / Process 
(FGA) 

Number of stream 1/process runs 
concentration to be averaged 

40002 Inject Valve Start  Time in seconds from start of cycle to inject 
valve start 

40003 Inject Valve Stop Time in seconds from start of cycle to inject 
valve stop 

40004 SSOValveStart Time in seconds from start of cycle to SSO 
valve start 

40005 SSOValveStop Time in seconds from start of cycle to SSO 
valve stop 

40006 Base Line Start  Cycle Time at which to start baseline 
acquisition 

40007 Base Line Stop  Cycle Time at which to stop baseline 
acquisition 

40008 Auto Zero Time Time in secs in cycle when baseline is 
automatically zeroed (display only) 

40009 Peak Start Time Cycle Time at which to start peak 
acquisition 

40010 Peak Stop Time Cycle Time at which to stop peak acquisition 

40011 Run Mode Cycle Sec Duration in seconds for 1 cycle 

40012 Instrument Status Bit level definition of Analyzer status - For 
internal use  

40013 Compat Last Zero 16-bit converted value of last run zero cycle 
(FGA) 

40014 Compat Last Span 16-bit converted value of last run span cycle 
(FGA) 

40015 State Flag Bit level definition - last settings saved in 
EEPROM in case of power failure – For 
internal use 

40016 Purge Seconds Purge Time in seconds when mode switch 
occurs 

40017 Reserved  

40018 Reserved  

40019 Reserved  

40020 FS_DAC1 Full Scale DAC1 in millivolts 

40021 FS_DAC2 Full Scale DAC2 in millivolts 

40022 Zero_DAC1 DAC1 lower value (output settings) 

40023 Zero_DAC2 DAC2 lower value (output settings) 

40024 Auto Cal Freq Days Auto Calibration frequency in days 

40025 Program ID (FGA/SGA/SLA sel) For internal use 

40026 Alarm Mask Bit mask to enable/disable ALARM 
checkboxes on System Settings screen 
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40027 Cal Cycles Number of calibration cycles set to run 

40028 Averages Smoothing filter setting (number between 1 
and 8) – set on Detector Settings screen 

40029 DAC1_PV DAC1 process variable choice  

40030 Cycle End Cycle mode setting : 0=stop, 1=repeat, 
2=hold; set on Detector Settings screen 

40031 PMT_Volts PMT Volts (value between 0 and 999) 

40032 Compat Last Validate 16-bit converted value of last run validate 
cycle (FGA) 

40033 Number of Cycles For internal use 

40034 Compat Last Process 16-bit converted value of last run process 
cycle (FGA) 

40035 DAC2_PV DAC2 process variable choice  

40036 Cal Units %, ppm, or ppb 

40037 Override Minutes Cabinet set purge override time in minutes 

40038 Secs Until Repeat Cycle hold time minimum before a new 
start event (Detector Settings screen) 

40039 TOD_Cal Time of Day for auto calibrate check, if 
enabled (hh * 60 + min) 

40040 Warn Mask Bit mask to enable/disable WARN 
checkboxes on System Settings screen 

40041 Stream 1 Runs Total cycles of Stream 1 set to run before 
switching 

40042 Stream 2 Runs Total cycles of Stream 2 set to run before 
switching 

40043 Stream 1 Density Density of Stream 1 - Value used to correct 
Stream 1 concentration for current cycle 
(for SLA only) 

40044 Stream 2 Density Density of Stream 2 - Value used to correct 
Stream 2 concentration for current cycle 
(for SLA only) 

40045 Calibration Density Density of the liquid span calibration 
standard used to calibrate instrument  
(for SLA only) 

40046 Output Average Stream 2 Number of stream 2 runs concentration to 
be averaged 

40047 MFC1 Initial Address Currently programmed MFC1 address 

40048 MFC1 Desired Address New address that will be programmed into 
MFC1 

40049 TC Failure Log For internal use 

40050 Alarm Mask2 Bit mask to enable/disable ALARM 
checkboxes on System Settings screen 
(extended to incorporate MFC3) 

40051 Warn Mask2 Bit mask to enable/disable WARN 
checkboxes on System Settings screen 
(extended to incorporate MFC3) 
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40052 Starting Stream Sets order of streams at start up – checkbox 
on Home Screen 

40053- 
40057 

Reserved  

40058 Count Of Violations For internal use 

40059 Defined Defined space for s/w use 

40060 MFC1 address For future implementation 

40061 MFC2 address For future implementation 

40062 MFC3 address For future implementation 

40063- 
40080 

Reserved  

 
 

R# Mnemonic Description (32-bit RW registers) 

40081-40082 Zero Cal Average Area Zero cal avg area response value 

40083-40084 Span Cal Average Area Span cal avg area response value 

40085-40086 Counts Per ppm Computed detector counts per ppm = Response 
Factor 

40087-40088 Zero Saved Last saved zero value 

40089-40090 Span_DAC1 High Value for DAC1 

40091-40092 Span_DAC2 High Value for DAC2 

40093-40094 BLOffset_uV User input baseline offset value in uV 

40095-40096 Span Cal ppb Span cal conc ppb value 

40097-40098 Zero Cal ppb Zero cal conc ppb value 

40099-40100 Last Validate ppm Last value of Validate calibration conc in ppm 

40101-40102 Span Saved Last saved value of Span calibration 

40103-40104 DCRF Multiplier For Internal use 

40105-40106 MFC1 Low MFC1 Low range setting 

40107-40108 MFC1 High MFC1 High range setting 

40109-40110 MFC2 Low MFC2 Low Range setting 

40111-40112 MFC2 High MFC2 High Range setting 

40113-40114 TC1 Low TC1 Low Range setting 

40115-40116 TC1 High TC1 High Range setting 

40117-40118 TC2 Low TC2 Low Range setting 

40119-40120 TC2 High TC2 High Range setting 

40121-40122 MFC 1 Set point MFC 1 Set point setting 

40123-40124 MFC2 Set point MFC 2 Set point setting 

40125-40126 TC1 Set point TC 1 Set point setting 

40127-40128 TC2 Set point TC 2 Set point setting 

40129-40130 TC3 Set point TC 3 Set point setting 

40131-40132 TC3 Low TC 3 Low Range Setting 

40133-40134 TC3 High TC 3 High Range Setting 

40135-40136 Zero Low Alarm Zero Low alarm setting 

40137-40138 Zero High Alarm Zero High alarm setting 

40139-40140 Span Low Alarm Span Low alarm setting 

40141-40142 Span High Alarm Span High alarm setting 
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40143-40144 Stream 1 Low Alarm Stream 1 Low alarm setting 

40145-40146 Stream 1 High Alarm Stream 1 High alarm setting 

40147-40148 Reserved  

40149-40150 RF Value User entered RF value (RF value in use) 

40151-40152 Reserved  

40153-40154 Zero Value Interference 
Correct 

For Internal use 

40155-40156 Timer 1 warn For Internal use 

40157-40158 Timer 2 shutdown For Internal use 

40159-40160 Reserved  

40161-40162 Stream 2 Low Alarm Stream 2 Low alarm setting 

40163-40164 Stream 2 High Alarm Stream 2 High alarm setting 

40165-40166 MFC3 Low Alarm MFC3 Low alarm setting 

40167-40168 MFC3 High Alarm MFC3 High alarm setting 

40169-40170 MFC3 Set point MFC 3 Set point setting 

40171-40240 Reserved  
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Section 5 – ATOM Scanner Features and Operation 
 

Section 5.1 ATOM Logs 
 

There are three event log files generated by the ATOM program that provide information about 

the ATOM programs’ operation: 

 AtomLog.txt 

 TrendLog.txt 

 DCSlog.txt 

When used in conjunction with each other the files provide a powerful debugging tool to isolate 

causes of operation errors.   

The log files are located in the “C:\ATOM!\AtomLog\” folder and provide chronological 

information about the status of the Analyzer, DCS communication as well as analyses results, 

and can be viewed/edited using Notepad.  Each log entry has a date and time stamp, followed 

by a line of text describing the event.  In the event that any of the log files or the AtomLog 

folder are moved or deleted, the Atom program will re-create a replacement folder and/or the 

files and will continue logging to the new files (in this event any previously logged data will be 

lost).   

 

Section 5.1.1 AtomLog.txt  
This log provides information about all system alarms and critical events and is basically a 

snapshot of the “System Settings” screen.    An “x” enclosed in brackets indicates a 

corresponding check box in the GUI that is checked/selected.  Empty brackets indicate that the 

corresponding box is un-checked/deselected.  The logic state of a Digital Input is indicated in 

parenthesis where (*) indicates the alarm state of a Digital Input.  The level of alarm is indicated 

by the names in parenthesis: (RED) Alarm, (YEL) Warn or (GRN) Normal. 

Sample AtomLog.txt file 

------------------------------------------------------------------------------ 
19/04/25  10:47:59  ATOM SLA Event Log Settings Snapshot 
------------------------------------------------------------------------------ 
19/04/25  10:47:59   
19/04/25  10:47:59       Atom Date: 04/18/2019   Version: 7.61 
19/04/25  10:47:59        GUI Date: 09/13/2018   Version: 2.0 
19/04/25  10:47:59   Detector Date: 04/18/2019   Version: 3.10 
19/04/25  10:47:59   
------------------------------------------------------------------------------ 
19/04/25  10:47:59   
19/04/25  10:47:59  Definitions:  
19/04/25  10:47:59      where: (*) State = ON, ( ) State = OFF 

A header is written when a new 

log file is created detailing the 

software version, followed by the 

current status of the System 

Settings – alarms, status of all 

check boxes, MFC and TC set 

points. 
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19/04/25  10:47:59      where: (GRN) = NORMAL, (YEL) = Warning, (RED) = Alarm 
19/04/25  10:47:59      ON  OFF   where: [x] = CheckedBox; [ ]= not CheckedBox 
19/04/25  10:47:59   
19/04/25  10:48:00  --------------------- Starting Atom ---------------------- 
19/04/25  10:48:00   
19/04/25  10:48:00      [x] Stream1 Select ON 
19/04/25  10:48:00      [ ] Stream2 Select OFF 
19/04/25  10:48:00          DI-1 Purge Loss OK (GREEN) 
19/04/25  10:48:00          DI-2 O² Pressure OK (GREEN) 
19/04/25  10:48:00          DI-3 Furnace Temperature ALARM (RED)  
19/04/25  10:48:00  [ ]     DI-4 Alarm Check OFF 
19/04/25  10:48:00      [ ] DI-4 Warn Check OFF 
19/04/25  10:48:00  [ ]     DI-5 Alarm Check OFF 
19/04/25  10:48:00      [ ] DI-5 Warn Check OFF 
19/04/25  10:48:00  [ ]     DI-6 Alarm Check OFF 
19/04/25  10:48:00      [ ] DI-6 Warn Check OFF 
19/04/25  10:48:00  [ ]     DI-7 Alarm Check OFF 
19/04/25  10:48:00      [ ] DI-7 Warn Check OFF 
19/04/25  10:48:00  [ ]     Zero Alarm Check OFF 
19/04/25  10:48:00      [ ] Zero Warn Check OFF 
19/04/25  10:48:00  [ ]     Span Alarm Check OFF 
19/04/25  10:48:00      [ ] Span Warn Check OFF 
19/04/25  10:48:00  [ ]     Stream1 Alarm Check OFF 
19/04/25  10:48:00      [x] Stream1 Warn Check OFF 
19/04/25  10:48:00  [ ]     Stream2 Alarm Check OFF 
19/04/25  10:48:00      [ ] Stream2 Warn Check OFF 
19/04/25  10:48:00  [ ]     MFC1 Alarm Check OFF 
19/04/25  10:48:00      [ ] MFC1 Warn Check OFF 
19/04/25  10:48:00  [ ]     MFC2 Alarm Check OFF 
19/04/25  10:48:00      [ ] MFC2 Warn Check OFF 
19/04/25  10:48:00  [ ]     TC1 Alarm Check OFF 
19/04/25  10:48:00      [ ] TC1 Warn Check OFF 
19/04/25  10:48:00  [ ]     TC2 Alarm Check OFF 
19/04/25  10:48:00      [ ] TC2 Warn Check OFF 
19/04/25  10:48:00  [ ]     TC3 Alarm Check OFF 
19/04/25  10:48:00      [ ] TC3 Warn Check OFF 
19/04/25  10:48:00  (GRN)   Zero Value      Low = 0  Value = 0  High = 1,000,000 ppb 
19/04/25  10:48:00  (GRN)   Span Value      Low = 0  Value = 0  High = 550,000,000 ppb 
19/04/25  10:48:00  (GRN)   Stream1 Value   Low = 0  Value = 0  High = 550,000,000 ppb 
19/04/25  10:48:00  (GRN)   Stream2 Value   Low = 0  Value = 0  High = 0 ppb 
19/04/25  10:48:00  (GRN)   MFC1 Value      L=0 V=0.0 H=0 (cc/min) 
19/04/25  10:48:00  (GRN)   MFC2 Value      L=0 V=0.0 H=0 (cc/min) 
19/04/25  10:48:00  (GRN)   MFC3 Value      L=0 V=0.0 H=0 (cc/min) 
19/04/25  10:48:00  (GRN)   TC1 Value       L=0.0°C V=0.0°C H=80.0°C 
19/04/25  10:48:00  (GRN)   TC2 Value       L=1040°C V=0°C H=1060°C 

The digital inputs DI1, DI2 and 

DI3 are system critical, and 

the Analyzer will not start 

analyses unless the status of 

ALL three DIs is GREEN.  In this 

example, DI3 is RED indicating 

that the furnace has not 

reached its set temperature 

for analysis to begin. 
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19/04/25  10:48:00  (GRN)   TC3 Value       L=0°C V=0.0°C H=40°C 
19/04/25  10:48:00  ---------------- End of Startup ----------------------- 

 
19/04/25  10:48:05  -------- On Start Up -------- 
19/04/25  10:48:05  RF Counts on Calibration dialog is set to 5,076,923 
19/04/25  10:48:05   
19/04/25  10:48:05  Calibration Units on Calibration dialog is set to ppb 
19/04/25  10:48:05  Purge time set to 21 secs 
19/04/25  10:48:05   
19/04/25  10:48:05  Calibration Cycles on Calibration dialog is set to 3 
19/04/25  10:48:05  Check Zero on Calibration dialog is set to 0 counts 
19/04/25  10:48:05   
19/04/25  10:48:05  Zero Average Concentration: 0 ppb 
19/04/25  10:48:05   
19/04/25  10:48:05  Check Span on Calibration dialog is set to 0 counts 
19/04/25  10:48:05   
19/04/25  10:48:05  Span Average Concentration: 0 ppb 
19/04/25  10:48:05   
19/04/25  10:48:05  Zero Conc on Calibration dialog is set to 0 ppb 
19/04/25  10:48:05  Span Conc on Calibration dialog is set to 6,500 ppb 
19/04/25  10:48:05  Online Maintenance on Home dialog is is ONLINE 
19/04/25  10:48:05  Frequency for Auto Check on Calibration dialog is set to 1 days. 
19/04/25  10:48:05   
19/04/25  10:48:05  Playback Demo on Calibration dialog is OFF 
19/04/25  10:48:05  PMTVolts on Detector dialog is set to 800 volts 
19/04/25  10:48:05  Filter on Detector dialog is set to 8 secs 
19/04/25  10:48:05  Zero Enabled on Detector dialog is set to OFF 
19/04/25  10:48:05  OFFset uV on Detector dialog is set to 0 uV 
19/04/25  10:48:05  Hold Time on Detector dialog is set to 0 secs 
19/04/25  10:48:05  Cycle Mode on Detector dialog is set to REPEAT 
19/04/25  10:48:05  Injection Start on Timed Event dialog is set to 7 secs 
19/04/25  10:48:05  Injection Stop on Timed Event dialog is set to 10 secs 
19/04/25  10:48:05  SSO/ARV Start on Timed Event dialog is set to 5 secs 
19/04/25  10:48:05  SSO/ARV Stop on Timed Event dialog is set to 12 secs 
19/04/25  10:48:05  Baseline Start on Timed Event dialog is set to 10 secs 
19/04/25  10:48:05  Baseline Stop on Timed Event dialog is set to 19 secs 
19/04/25  10:48:05  Auto Zero Time on Timed Event dialog is set to 0 secs 
19/04/25  10:48:05  Peak Start on Timed Event dialog is set to 20 secs 
19/04/25  10:48:05  Peak Stop on Timed Event dialog is set to 70 secs 
19/04/25  10:48:05  Cycle Time on Timed Event dialog is set to 100 secs 
19/04/25  10:48:05   
19/04/25  10:48:05   
19/04/25  10:48:05  Stream 2 disabled on Home dialog 
19/04/25  10:48:05  Stream 1 Cycles on Home dialog set to 5 
19/04/25  10:48:05  Stream 2 Cycles on Home dialog set to 0 
19/04/25  10:48:05  Starting Stream on Home dialog is set to 1 
19/04/25  10:48:05  Run/Stop button on Home page is set to ON 
19/04/25  10:48:05   
19/04/25  10:48:05  Purge Override is set to ON for 10 minutes 
19/04/25  10:48:05   
19/04/25  10:48:05  Purge Override is set to OFF 
19/04/25  10:48:05   

In addition to the System 

Settings, the log file records 

changes made by the user to 

any of the software menu 

settings. 

As seen here, Stream 2 was 

disabled, and number of 

Stream 1 cycles to be run was 

changed to 5.  

 

As an example, the 

Response Factor 

(RF) was manually 

changed to 

5,076,923, and the 

Purge Time was set 

to 21 seconds. 
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19/04/25  10:48:05  TC1 Low set to 0°C 
19/04/25  10:48:05   
19/04/25  10:48:05  TC1 High set to 80°C 
19/04/25  10:48:05   
19/04/25  10:48:05  TC1 Set Point set to 70 °C 
19/04/25  10:48:05   
19/04/25  10:48:05  TC2 Low set to 1040°C 
19/04/25  10:48:05   
19/04/25  10:48:05  TC2 High set to 1060°C 
 
19/04/25  10:48:05   
19/04/25  10:48:05  TC2 Set Point set to 1050 °C 
19/04/25  10:48:05   
19/04/25  10:48:05  TC2 violations reset to 0 
19/04/25  10:48:05   
19/04/25  10:48:05  TC3 Low set to 0°C 
19/04/25  10:48:05   
19/04/25  10:48:05  TC3 High set to 40°C 
19/04/25  10:48:05   
19/04/25  10:48:05  TC3 Set Point set to 30 °C 
19/04/25  10:48:05   
19/04/25  10:48:05  MFC1 Low set to 115 cc/min 
19/04/25  10:48:05   
19/04/25  10:48:05  MFC1 High set to 125 cc/min 
19/04/25  10:48:05   
19/04/25  10:48:05  MFC1 Set Point set to 120 cc/min 
19/04/25  10:48:05   
19/04/25  10:48:05  MFC2 Low set to 0 cc/min 
19/04/25  10:48:05   
19/04/25  10:48:05  MFC2 High set to 0 cc/min 
19/04/25  10:48:05   
19/04/25  10:48:05  MFC2 Set Point set to 0 cc/min 
19/04/25  10:48:05   
19/04/25  10:48:05  MFC3 Low set to 0 cc/min 
19/04/25  10:48:05   
19/04/25  10:48:05  MFC3 High set to 0 cc/min 
19/04/25  10:48:05   
19/04/25  10:48:05  MFC3 Set Point set to 0 cc/min 
19/04/25  10:48:05   
19/04/25  10:48:05  PMT HV on Home dialog is set to ON 
19/04/25  10:48:05   
19/04/25  10:48:05  UV Lamp on Home dialog is set to ON 
19/04/25  10:48:05   

 
 
Other events include Check Calibration events as they occur. 
 
16/07/13 09:58:22 Auto Check Time Set: 00:10:00 (DD:HH:MM) 
16/07/13 09:59:09 (GRN)   Stream 2 Value  
16/07/13 10:00:00 Auto Check Event Initiated 
16/07/13 10:00:40 Begin Zero Check cycle 

MFC1 low alarm 

value set to 115 

cc/min, the high 

alarm value set to 

125 cc/min, and 

the Set Point at 

120 cc/min. 
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16/07/13 10:03:30 End Zero Check Cycle 
16/07/13 10:03:30 Begin Span Check cycle  
16/07/13 10:06:19 End Span Check Cycle 
16/07/13 10:06:19 Begin Validate Check cycle  
16/07/13 10:09:09 End Validate Check Cycle 
16/07/13 10:15:25 Calculate RF 
16/07/13 10:15:28 Save Calibration 

 

 

Section 5.1.2 Trend Log 
 

The Trend Log is a comma delimited text file that contains the results of all analyses.  It is 

organized in a format compatible for importing into EXCEL.   

Sample TrendLog.txt file 

When it begins logging, the TrendLog.txt file prints a header which has a date and time stamp, 
Run Cycle (count of cycles run since analyzer was last started), Stream Cycle (how many of the 
pre-set stream/calibration cycles have been completed), and Stream and Calibration 
concentrations.  

 
 
YY/MM/DD  HH:MM:SS Run Stream Stream1  Stream2  Zero Span Validate 
                       Cycle    Cycle       (ppb)   (ppb)          (ppb)       (ppb)        (ppb) 
19/05/01  10:06:34      24       1          112,449                                         
19/05/01  10:08:15      25       2           30,208                                         
19/05/01  10:09:56      26       1                         54,084                           
19/05/01  10:11:37      27       2                         47,810                           
19/05/01  10:13:19      28       1           30,074                                         
19/05/01  10:15:00      29       2           29,882                                         
19/05/01  10:16:41      30       1                         41,501                           
19/05/01  10:18:22      31       2                         35,204                           
19/05/01  10:20:03      32       1           30,208                                         
19/05/01  10:21:44      33       2           30,322                                         
19/05/01  10:23:25      34       1                         28,913                           
19/05/01  10:25:06      35       2                         22,555                           
19/05/01  10:26:48      36       1           29,882                                         
19/05/01  10:28:29      37       2           30,048                                         
19/05/01  10:30:10      38       1                         16,123                           
19/05/01  10:31:51      39       2                         16,131 
19/05/01  13:12:26      39       1                                                     500 
19/05/01  13:14:07      40       2                                                     481 
19/05/01  13:15:48      41       3                                                     534 
19/05/01  13:12:26      42       1                                                      6,500 
19/05/01  13:14:07      43       2                                                      6,481 
19/05/01  13:15:48      44       3                                                      6,534 
19/05/01  13:12:26      45       1                                                       1,500 
19/05/01  13:14:07      46       2                                                       1,481 
19/05/01  13:15:48      47       3                                                       1,534 

Here, the user has 

clicked on the “Calculate 

RF” button and then re-

calibrated the Analyzer 

by clicking on “Save 

Calibration” 
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Following is an example of the above TrendLog.txt file when exported into Excel (Figure 5.1). 
 

 
Figure 5.1 – Exported TrendLog Excel File 

 
 

Section 5.1.3 DCS Log 
 
The DCSLog.TXT file maintains a running log of all “Control” signals received by the ATOM from 

the DCS / PLC, i.e. the log records the status of Modbus Control Registers in the range between 

R00001 and R00064. 

When used in conjunction with AtomLog, it helps ascertain whether or not a particular change 

in status of the Analyzer was requested by the DCS / PLC.   

Sample DCSLog.txt file 

19/03/30  05:48:12  R20 Stream 2 Enable = ON 
19/03/30  05:48:17  R2 Run = ON 
19/03/30  05:50:32  R2 Run = OFF 
19/03/30  05:51:04  R20 Stream 2 Enable = OFF 
19/03/30  05:51:14  R21 Zero Enable = ON 
19/03/30  05:51:19  R2 Run = ON 
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19/03/30  05:53:32  R2 Run = OFF 
19/03/30  05:54:04  R21 Zero Enable = OFF 
19/03/30  05:54:14  R19 Stream 1 Enable = ON  
19/03/30  05:54:19  R2 Run = ON 
19/03/30  05:56:32  R2 Run = OFF 
19/03/30  05:57:04  R19 Stream 1 Enable = OFF 
19/03/30  05:57:14  R20 Stream 2 Enable = ON 
19/03/30  05:57:19  R2 Run = ON 
19/03/30  05:59:33  R2 Run = OFF 
19/03/30  06:00:05  R20 Stream 2 Enable = OFF 
19/03/30  06:00:15  R21 Zero Enable = ON 
19/03/30  06:00:20  R2 Run = ON 
19/03/30  06:02:35  R2 Run = OFF 
19/03/30  06:03:05  R21 Zero Enable = OFF 
19/03/30  06:03:15  R19 Stream 1 Enable = ON 
19/03/30  06:03:20  R2 Run = ON 
19/03/30  06:05:33  R2 Run = OFF 
19/03/30  06:06:05  R19 Stream 1 Enable = OFF 
19/03/30  06:06:15  R20 Stream 2 Enable = ON 
19/03/30  06:06:20  R2 Run = ON 
19/03/30  06:08:33  R2 Run = OFF 
19/03/30  06:09:05  R20 Stream 2 Enable = OFF 
19/03/30  06:09:16  R21 Zero Enable = ON 
19/03/30  06:09:20  R2 Run = ON 
19/03/30  06:11:34  R2 Run = OFF 
19/03/30  06:12:06  R21 Zero Enable = OFF 
19/03/30  06:12:16  R19 Stream 1 Enable = ON 
19/03/30  06:12:21  R2 Run = ON  

This sample log is taken from an 

Analyzer that is totally 

controlled by a PLC.  As seen in 

this sample log, the PLC stops 

the analysis at the end of every 

cycle (R00002 = OFF), actuates 

one of registers R00019, R00020 

or R00021 (selects stream to 

run), and then re-starts the 

analysis (R00002 = ON). 
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Section 5.2 ATOM2 Features 
 
The ATOM2 comes with certain features that are not accessible through the GUI.  Among the 
main ones, they provide the user with extended and user-selectable data logging, fully 
accessible Modbus map to verify DCS data validity, and ability to program MFC addresses. 
 
 

Section 5.2.1 Accessing the ATOM2 menus - Login 
 

Caution:   Accessing these menus gives user the ability, to change Temperature and 
Mass Flow Controller settings (among others).  Any un-authorized 
changes to these settings could result in erroneous results and/or 
damage to the Analyzer. 

 

In order to access all the ATOM2 features, the user will need to login using a password that is 
independent of the GUI.  (Please check with your supervisor for login privileges.) 

 

On the ATOM program, click on “Login” as shown below in Figure 5.2.  Enter the login password 
using the On-Screen Keyboard, and click OK. 

 

 
Figure 5.2 – ATOM Login 

 
Once login is successful user will be able to make changes to Analyzer menus. 
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Section 5.2.2 Accessing the Modbus Map 
 
On the ATOM program, click on “File” and “Show Registers" as shown below in Figure 5.3. 
 

 
Figure 5.3 – Show Registers 

 
By individually selecting the Holding, Input, Coil, or Input Discrete registers will bring up the 
entire table of the corresponding Modbus registers with the updated current value in unsigned 
integer format.   

Selecting “All Registers” will simultaneously bring up all 4 Modbus tables (Figure 5.4). 

 

 
Figure 5.4 – All Modbus tables 

  



190514 ATOM SLA Manual Rev A  SLA-1000 User’s Manual 
 

SLA-1000 User’s Manual   Page | 133 

Interpreting the Modbus Data 
 
The Modbus data for Holding and Input Registers is either stored in a single 16-bit register or in 
a 16-bit register pair.   
The data in the single 16-bit register is read as-is.  To interpret the data in the register pair, 
apply the following math to the two registers: 
 
(Higher order 16-bit register X 65536) + (Lower order 16-bit register) 
 
For example, in the register pair R30001-02, R30001 is the higher order 16-bit register, and 
R30002 is the Lower order 16-bit register. 
 
The Input and Coil registers are single bit registers and can only have one of two states: 
True=1, False=0. 
 

 

Section 5.2.3 Open All Windows 
 
Clicking on “File” and “Open All Windows” will pull up and cascade all menus (Figure 5.5). 
 

 
Figure 5.5 – Open All Windows 
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Section 5.2.4 Extended Data Logging 
 
On the ATOM program, clicking on “File” (Figure 5.6), and then “Start Data Collection” opens a 
dialog window (Figure 5.6). 
 

 
Figure 5.6 – Start Data Collection 

 
 

This window lets user select parameters to log (Figure 5.7).   
 

 
Figure 5.7 – Start Data Collection Dialog Box 

 
 
From the list of Registers in the left side pane, select the parameters you wish to log.  Then click 
on the “>” button to transfer the parameter to the “Items to Save” pane on the right.  When 
you are done with the selections, click “Start”.  This will start data logging to the 
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“DataCollection.txt” file located at C:\ATOM!\ directory.  The data can be set to log every 
second (By elapsed time), or at the end of every cycle (By cycle).  This selection applies to ALL 
selected parameters, and cannot be set for individual parameters. 

Clicking “Clear Right” will clear all current selections and you can start over. 

The data logging can be stopped by clicking on “File” and then “Stop Data Collection” on the 
ATOM program. 

 

Section 5.2.5 Replacing a MFC and programming the correct address  
 
Depending upon the application, the online Analyzer may consist of up to 3 MFCs.  This option 
enables users to install a new MFC and program it to the required address with a single click of 
a button (Note: this option will only work if the default MFC address = 0).   

Install the new MFC, connect the communication cable to the single MFC whose address needs 
to be programmed.  Disconnect all other MFCs, if present.  On the ATOM program, click on 
“File” and “Set MFC Address" as shown below in Figure 5.8. 

  

 
Figure 5.8 – Set MFC Address 

 

For example, if MFC1 has been replaced, in the dialog box click on “Set MFC1 Address”.  The 
ATOM program will automatically set the MFC1 address to 11.  A “ ” indicates that 
programming was complete.  Click on the    to close the dialog box (Figure 5.9). 

 

  
      Figure 5.9 – Dialog Box 

 

Note:  For applications that also contain 
MFC2 and/or MFC3, their respective 
addresses will be automatically 
programmed to 12 and 13. 
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Section 5.2.6 Changing MFC addresses  
 
In addition to programming addresses for new MFCs, it is also possible to re-program a MFC 
address provided that its’ current address is known.   

This utility can be accessed in the ATOM program’s System Setup window. 

To begin, if multiple MFCs are installed, disconnect all MFC communication cables except to the 
MFC whose address needs to be changed (Figure 5.10). 

 
 

 
Figure 5.10 – MFC Communication cables 

 

 
 
 
  

MFC communication cable 
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On the ATOM program, click on “System”, and the System Settings window will open as shown 
below in Figure 5.11.   

 
 

 
Figure 5.11 – Change MFC address 

 

In the “MFC Existing Address” textbox, enter “0” (or the current address of the MFC).  In the 
“MFC Desired Address” textbox enter the desired MFC address – typically 11, 12, or 13.  Click 
on “Change Address”.  The MFC will now be programmed to the new address.  Re-connect all 
the MFC communication cables to resume normal Analyzer operation. 
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Section 5.2.7 Changing the MFC and TC Set Points 
 
On the ATOM program, click on “System”, and the System Settings window will open as shown 
below in Figure 5.12. 

 

 
Figure 5.12 – MFC and TC Set Points 

 

Click on the device’s button whose set point you wish to change.  In the dialog box that opens 
enter the new Set point and click OK (Figure 5.13).  Once the new set point is accepted by the 
device (MFC or TC), the new set point is read back by the ATOM and displayed in the “Readback 
Set Point” text box. 

 

 
Figure 5.13 – Dialog Box 
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Section 5.2.8 Data Display 
 
On the ATOM program, click on “Data Table” as shown below in Figure 5.14, which will open a 
drop-down menu of all data tables available for viewing. 
 

 
Figure 5.14 – Data Tables selection menu 
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The process (streams 1 and 2) and calibration results will be displayed as shown below in 

Figures 5.15 and 5.16. 

 

 
Figure 5.15: Process Streams data tables 

 
 
 
 
 
 
 
 
 
 



190514 ATOM SLA Manual Rev A  SLA-1000 User’s Manual 
 

SLA-1000 User’s Manual   Page | 141 

 
Figure 5.16: Calibration data tables 
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Section 6 – Postscript 
 

Section 6.1 Procedure To Auto-Tune Temperature Controller 
 

Whenever the thermocouple is replaced, the Temperature Controller needs to be “Auto-
Tuned” for optimal performance.  This is an automatic procedure which sets the PID control 
parameters that the Temperature Controller uses to maintain the “set” temperature value.   
 

Before beginning the Auto-Tuning procedure: 
 

 Install the new thermocouple (verify that the polarity is correct) 

 For proper Auto-Tuning, the furnace temperature must be cooled to less than 90% 
of the set point value (for a Set Point of 1050°C, less than 940 °C) 

 Verify that the Furnace breaker is switched ON 

 Verify that the Analyzer is in “Purge Override” (otherwise power to the furnace will 
remain disabled) 

 

Begin: 
 

  
  

  
 

    
 

Press the key while holding down the  key and the 
Temperature Controller reads “AT” and the first line and “----” on the 
second line.      
 

Press the  key and both the top and bottom line on the 
Temperature Controller will read “AT”.      
 

Press the key to start the “Auto-Tune” procedure.  The  
“AT” indicator will begin to flash ON and OFF, and the furnace 
temperature will begin to increase indicating that the Auto-Tune 
procedure is in progress.   
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Once the procedure is complete, the “AT” indicator will automatically turn OFF, and the 
optimized PID values should maintain the furnace at its set temperature. 
 

**Note :  During the Auto-tuning procedure it is normal for the furnace temperature to 
briefly over-shoot the set temperature value.   
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Section 6.2 Calibration/Validation Procedure 
 

The Calibrate settings screen (Figure 6.1) is where all information regarding instrument 
calibration and associated calibration results are displayed.  
 

To access this screen press Settings > Calibrate Settings 

 
Figure 6.1 – Calibrate Settings Screen 

 

Manual Calibration:  
 
Settings  
 
1. Cycles/set ①: Set this to 5.  
2. Purge (Sec) ②: Set this to 60.  
3. Check Zero ③: Set this to 0 (zero).  
4. Zero Conc ④: Set this to 0 (Zero).  
5. Span Conc ⑤: Set this to SO2 concentration in the span/cal standard.  
6. Cal Units ⑥: Select unit based on the format of the value entered in Span Conc.  
 
Procedure  
 
1. Select Run Span ⑦. After 5 cycles of Span is completed, value in Check Span ⑧ will get 
    updated.  
2. Select Calculate RF ⑨. Wait for the value to get updated in RF=Count/ppm ⑩.  
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3. Select Save Calibration ⑪ after the indicator on this button turns green.  
4. Values in Saved Zero ⑫ and Saved Span ⑬ will get updated and will be same as ③ & ⑧.  
 
 

Manual Validation:  
 
Settings  
 
1. Keep all the settings same as in Manual calibration.  
 
Procedure  
 
1. Select Run Span ⑦.  
2. Select View Results ⑭. Screen Check Calibration Results will open (Figure 6.2).  
 

 
Figure 6.2 – Check Calibration Results Screen 

 
3. After 5 cycles are completed the value at ⑮ should be value of SO2 concentration in   
    span/cal standard.  
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APPLICABLE REQUIREMENTS 
 

CSA Standard C22.2 No 0-10 - General Requirements - Canadian Electrical Code, Part II 

CSA Standard C22.2 No 0.4-04 - Bonding of Electrical Equipment 

CSA Standard C22.2 No 142-M1987 - Process Control Equipment 
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Certificate: 2744021 
 

 

 

LTR 10E-2005 - Purged and Pressurized equipment for use in Class I Hazardous 
Locations – North American (Division System) Purging based on NFPA- 496 

UL 508 17
th 

Ed. - Electric Industrial Control Equipment. 

NFPA 496:2013 - Purged and Pressurized Electrical Equipment. 
 

 

MARKINGS 

Y Submittor’s name. Y  

Model designation. Y  

Electrical ratings.        Y  

Serial number. 

Y Hazardous Location designation 

Y Temperature code 

Y Purge type 

Y The following statement: 
 

 

 “WARNING: EXPLOSION HAZARD - SUBSTITUTION OF COMPONENTS MAY IMPAIR 

SUITABILITY FOR CASS I, DIVISION. 2. Or equivalent 

 

 

Y  WARNING; Enclosure shall not be opened unless the area is known to be Non-hazardous, or 

unless all devices within the enclosure have been de-energised. Power must not be 

restored after enclosure has been opened until enclosure has been purged for 10 Minutes at 30 PSIG Note; 

Read all labels before operating this purged system. 

 

Y  “Type Z Purge System.” 

 

Y  “WARNING; Hot internal components, wait 3 hours prior opening enclosure prior to work.” Or equivalent. 
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